




Microsoft® Visio® 2010
Step by Step

Scott A. Helmers



Copyright © 2011 by Scott A. Helmers.

All rights reserved. No part of the contents of this book may be reproduced or transmitted in any form or by any 
means without the written permission of the publisher.

Unless otherwise noted, the example companies, organizations, products, domain names, email addresses, logos, 
people, places, and events depicted herein are fictitious. No association with any real company, organization, product, 
domain name, email address, logo, person, place, or event is intended or should be inferred.

Microsoft Press titles may be purchased for educational, business, or sales promotional use. Online editions are also 
available for most titles (http://my.safaribooksonline.com). For more information, contact our corporate/institutional 
sales department: (800) 998-9938 or Microsoft Press, Inc.

Complying with all applicable copyright laws is the responsibility of the user. Without limiting the rights under 
copyright, no part of this document may be reproduced, stored in or introduced into a retrieval system, or transmitted 
in any form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or for any purpose, 
without express written permission of Microsoft Press, Inc.

6 7 8 9 10 11 12 13 14  LSI  8 7 6 5 4 3

Microsoft, Microsoft Press, the Microsoft Press brand, Access, ASP.NET, DirectX, DreamSpark, Deep Zoom, Excel, 
Expression Blend, Expression Design, Expression Encoder, Expression Studio, Expression Web, FrontPage, .NET, 
Office, Silverlight, SQL Server, Visual Basic, Visual C++, Visual C#, Visual Studio, Visual Web Developer, Web Platform, 
WebsiteSpark, and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United 
States and/or other countries.

This book expresses the author’s views and opinions. The information contained in this book is provided without any 
express, statutory, or implied warranties. Neither the author, Microsoft Corporation, nor their 
respective resellers, or distributors will be held liable for any damages caused or alleged to be caused either directly 
or indirectly by this book.

Acquisitions and Developmental Editor: Kenyon Brown
Production Editor: Adam Zaremba
Editorial Production: Online Training Solutions, Inc.
Technical Reviewer: John Marshall
Illustrator: Robert Romano
Indexer: Lucie Haskins
Cover: Karen Montgomery

978-0-735-64887-6
           [2013-07-19]



	 	 	 iii

What	do	you	think	of	this	book?	We	want	to	hear	from	you!	
Microsoft	is	interested	in	hearing	your	feedback	so	we	can	continually	improve	our	books	and	learning	resources	
for	you.	To	participate	in	a	brief	online	survey,	please	visit:	

microsoft.com/learning/booksurvey

Contents
Introducing	Visio	2010	 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ix
Modifying	the	Display	of	the	Ribbon . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xiii
Features	and	Conventions	of	This	Book . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xix
Using	the	Practice	Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxi
Getting	Support	and	Giving	Feedback . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxiii
Your	Companion	eBook. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxv
Acknowledgments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxvii

	 1	 	A	Visual	Orientation	to	a	Visual	Product	 1
Getting Started with Visio 2010  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2

Visio Standard  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2
Visio Professional  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4
Visio Premium  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 4

Exploring the Backstage View  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 6
Using the Visio Ribbon  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 9
Resizing the Ribbon  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 13
Minimizing the Ribbon  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 14
Understanding Contextual Tabs  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 15
Understanding Add-in Tabs .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 16
Understanding Shapes, Masters, Stencils, and Templates  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 16
Exploring the Drawing Window  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 17
Managing the Shapes Window  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 20
Panning and Zooming in Visio  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 24
Resizing and Repositioning Shapes  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 29
Key Points  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 35



iv   Contents

 2  Creating a New Diagram 37
Using Basic Shapes and the Dynamic Grid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Selecting Shapes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Copying and Pasting Shapes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Connecting Shapes with Lines. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
Connecting Shapes with Dynamic Connectors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Identifying 1-D Shapes and Types of Glue . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Positioning Shapes with Rulers and Guides . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
Using AutoConnect and Quick Shapes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Using AutoAdd and AutoDelete . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
Starting a New Diagram from a Sample Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

 3  Adding Sophistication to Your Drawings 69
Adding Text to Shapes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
Creating and Formatting Text Boxes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
Orienting Shapes on the Page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
Orienting Shape Text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
Positioning Shape Text  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
Adding ScreenTips and Comments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
Using Shape Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .84
Inserting Fields: The Basics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86
Grouping Shapes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88
Inserting Pictures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92
Understanding Layers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .94
Managing Pages and Page Setup. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
Working with Background Pages and Borders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .104
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .109



 Contents  v

 4  Drawing the Real World: Flowcharts and 
Organization Charts 111

Selecting a Flowchart Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .112
Visio Standard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .112
Visio Professional . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .112
Visio Premium . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .113

Creating Flowcharts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114
Adding Labels to Flowcharts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .118
Understanding Swimlane Diagrams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .119
Creating Swimlane Diagrams. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .120
Understanding Organization Charts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .125
Building an Organization Chart by Hand . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .126
Using the Organization Chart Wizard with Existing Data. . . . . . . . . . . . . . . . . . . . . .130
Using the Organization Chart Wizard with New Data . . . . . . . . . . . . . . . . . . . . . . . .138
Enhancing Org Charts with Pictures. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141 5  Adding Style, Color, and Themes 143
Aligning and Spacing Shapes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .144
Using the Auto Align & Space Feature. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .148
Applying Color and Fill Patterns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .150
Applying Line Styles and Colors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .154
Using the Format Painter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .157
Turning Off the Grid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .158
Applying Themes to Your Diagrams: Part 1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161
Applying Themes to Your Diagrams: Part 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163
Customizing Themes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .166
Setting Theme Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .168
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .169



vi   Contents

 6  Entering, Linking to, and Reporting on Data 171
Understanding Shape Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172
Viewing Shape Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172
Editing Shape Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175
Viewing Shape Data Attributes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .177
Changing Shape Data Attributes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 179
Creating New Shape Data Fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .184
Linking Diagrams to External Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .186
Refreshing All Data in Linked Diagrams. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .193
Refreshing Selected Data in Linked Diagrams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .195
Scheduling Data Refresh . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .196
Linking Data to Shapes Automatically . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .197
Running a Predefined Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .200
Creating a New Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .205
Modifying an Existing Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 210
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .212

 7  Adding and Using Hyperlinks 215
Enhancing Diagrams by Adding Hyperlinks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 216
Using Hyperlinks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 217
Linking to a Website . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .218
Linking to a Document . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .219
Linking to a Specific Location in a Document . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .221
Linking to Another Visio Page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .224
Understanding Relative and Absolute Hyperlinks . . . . . . . . . . . . . . . . . . . . . . . . . . . .226
Setting the Hyperlink Base. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 231
Editing Existing Hyperlinks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .233
Adding Multiple Hyperlinks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .234
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .236

 8  Sharing and Publishing Diagrams: Part 1 239
Previewing and Printing Visio Diagrams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .240
Removing Personal Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 245
Creating Graphics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247
Saving in Other File Formats . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 252
Creating Visio Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 255



 Contents  vii

Sharing Diagrams by Using the Visio Viewer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .260
Publishing Visio Diagrams to the Web. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 261
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .268

 9  Drawing the Real World: Network and Data 
Center Diagrams 271

Building Basic Network Diagrams. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .272
Building Detailed Network Diagrams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .275
Organizing Network Shapes in a Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .278
Creating Rack Diagrams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .280
Adding Equipment to Rack Diagrams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .283
Changing the Drawing Scale . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .289
Running Computer and Network Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .292
Searching and Replacing Text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .294
Mapping Active Directory and LDAP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .296
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .297

 10  Visualizing Your Data 299
Enhancing Diagrams with Data-Driven Graphics . . . . . . . . . . . . . . . . . . . . . . . . . . . . .300

Network Equipment Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .300
Process Improvement Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .302
Casino Operation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .303
Risk Management . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .303

Using Existing Data Graphics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .304
Editing Data Graphics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .307
Creating New Data Graphics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 313
Creating Data Graphic Legends . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 317
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 319

 11  Adding Structure to Your Diagrams 321
Comparing Containers and Groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .322
Working with Containers and Their Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .328
Formatting Containers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 331
Sizing Containers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 331
Adding Shapes to Lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 333
Formatting and Sizing Lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 337



viii   Contents

Finding Containers and Lists in Visio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .338
Swimlanes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .338
Wireframes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .342
Legends . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .347

Annotating Shapes with Callouts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .348
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .352

 12  Creating and Validating Process Diagrams 355
Understanding Visio Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .356
Validating Flowcharts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 357
Understanding BPMN. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .361
Creating and Validating BPMN Diagrams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .362
Creating Subprocesses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .366
Creating and Exporting SharePoint Workflow Diagrams . . . . . . . . . . . . . . . . . . . . . . 370
Reusing Existing Validation Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .373
Creating New Validation Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 375
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .377

 13  Sharing and Publishing Diagrams: Part 2 379
Customizing Diagrams Saved as Websites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .380
Saving Visio-Created Websites on a SharePoint Server . . . . . . . . . . . . . . . . . . . . . . .387
Understanding Visio Services . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .389
Publishing Visio Drawings to SharePoint 2010 Visio Services . . . . . . . . . . . . . . . . . .390
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .398

Appendix: Looking Under the Hood. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 399

Glossary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 411

Index. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 419

About the Author. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 439

What do you think of this book? We want to hear from you! 
Microsoft is interested in hearing your feedback so we can continually improve our books and learning resources 
for you. To participate in a brief online survey, please visit: 

microsoft.com/learning/booksurvey



 Introduction  ix

Introducing Visio 2010
Microsoft Visio 2010 is a bold new release. If you’re new to Visio, your timing is excellent! 
This version of Visio is easier to use than ever before and yet the diagrams you create 
can have more impact and style, and can present more real-world data than in any pre-
vious version. 

If you’ve used prior versions of Visio, you’re in luck too. You’ll find the features you love, 
but you’ll see them presented with the new Visio ribbon. In addition, you’ll discover that 
you can publish dynamically updateable diagrams to Microsoft SharePoint, where any-
one can view them, even if they don’t have Visio. You’ll find new templates and stencils, 
faster methods for creating drawings, simple ways to add structure to your diagrams, 
improved integration with AutoCad drawings, diagram validation rules, and a wealth of 
other new features.

In short, whether you’re a first timer or have been using Visio for years, this is the strongest 
and most exciting version of Visio yet.

Creating and Enhancing Diagrams More Easily
Quick Shapes, AutoConnect, AutoAdd, AutoDelete, AutoAlign, AutoSize… just the names 
of some of the new and enhanced features in Visio 2010 suggest that creating diagrams 
will be simpler. A few examples include the following:

● Want to add a new shape to the page? For commonly used shapes, there’s no 
need to move the pointer to the stencil and drag a shape onto the page. Just point 
to a shape that’s already on the page and the QuickShapes menu offers you four 
shapes. One click and you’ve not only added a new shape but it’s already connect-
ed to the existing shape.

● Need to insert a shape between two existing shapes? Simply drop the new shape 
onto the connector between two existing shapes. Not only will AutoAdd insert the 
new shape but it will add a new connector. And if there isn’t enough room for the 
new shape, Visio will even rearrange part of the diagram to make room.

● Want to delete a shape that’s connected between two others? Just select the shape 
and press the Delete key. Self-healing connectors do the rest; the shapes on either 
side of the deleted shape will be connected to each other.
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● Need to enlarge the drawing page and print the new diagram across multiple 
sheets of paper? Simply drag a shape into the space surrounding the drawing 
page and AutoSize will add a new page. That’s it! No other adjustments or setting 
changes required.

● Don’t like the way your shapes are aligned on the page? Click the Auto Align & 
Space button and Visio rearranges your diagram. Not quite happy with the result? 
Undo the changes, move a few shapes around, and then click Auto Align & Space 
again.

● Need to present your diagram to an audience but think the drawing is a bit boring? 
Open the Visio 2010 Themes gallery: one click applies a suite of coordinated colors, 
styles, fonts, line patterns, and effects to every shape. You can also apply predesigned 
page backgrounds or page borders by selecting one from a new gallery.

Visio 2010 also brings Live Preview to your diagrams. Many of the features listed above, 
along with most font, color, size, and style changes, take advantage of Live Preview to 
show you a potential change before you make it. Live Preview even extends to Visio 
Data Graphics, letting you preview the dynamic presentation of the data behind your 
shapes.

Adding Structure to Visio Diagrams
Many types of Visio diagrams contain sets of shapes that are related to each other. In 
previous Visio versions, you could visually suggest the relationships by creating some 
combination of groups, colored background shapes, or borders. 

Visio 2010 introduces a new type of shape called a container that provides more than 
just a visual grouping for a set of shapes. The container structure means that shapes in 
a container know they are contained, and the container knows the members that reside 
within it. Consequently, when you move, copy, or delete a container, all of the members 
go with it. However, unlike a group shape, the member shapes are accessible with a 
single click just as if the container were not there.

In most containers, you can place member shapes wherever you’d like. However, a list is 
a special type of container that maintains members in ordered sequence. Each list mem-
ber knows exactly where it resides within the list.

Visio 2010 includes a third type of structured diagram component known as a callout. 
You still use new-style callouts to add annotations to other shapes, but both the callout 
and the target shape are aware of each other. Once again, this improves many user in-
terface actions, but also allows Visio add-ins to work more intelligently with annotated 
shapes.
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Containers, lists, and callouts are great for Visio users, but they also offer intriguing op-
tions to Visio developers for building location-aware shapes and for writing code that 
takes advantage of diagram structure.

Publishing to SharePoint
In Visio 2010, as in previous versions of Visio, you can save any Visio drawing as a set 
of webpages. This was, and is, a tremendously useful capability because it allows any-
one with Windows Internet Explorer to view your web-published Visio diagram without 
needing Visio.

Although this publishing option has many advantages, it also has one fundamental 
drawback: the published drawings are static. If the diagram changes or the underlying 
data changes, you need to republish the drawing before users can see the changes.

The combination of Visio 2010 and SharePoint Server 2010 Visio Services introduces a 
new option that you can use to publish dynamically updateable Visio web drawings. You 
can publish drawings that contain live connections to external data sources and fea-
ture data graphics to visualize the data behind the diagram. When the underlying data 
changes, or certain aspects of the diagram change, Visio Services on SharePoint ensures 
that the web drawing is automatically updated.

You needn’t stop with simply publishing a web drawing, either. You can create Web Parts 
to contain your Visio drawings and can even create interactions among Web Parts so 
that published Visio drawings interact with each other and with non-Visio Web Parts.

Managing Business Processes
The Premium edition of Visio 2010 adds several new templates that are specifically focused 
on business process and also adds a number of process-related features. 

Using the Business Process Management Notation (BPMN) template, you can create pro-
cess maps that conform to the BPMN 1.2 standard.

With the SharePoint Workflow template, you can create a visual layout of a SharePoint 
workflow, export it to SharePoint Designer for refinement and completion, and then 
execute the workflow in SharePoint. You can also bring a SharePoint Designer workflow 
back into Visio in order to see a graphical representation. 
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The Process tab in Visio Premium 2010 includes several new buttons for automatically 
creating and managing subprocesses within a process diagram.

Validating Diagrams
Visio 2010 validation rules, which are part of Visio Premium 2010, introduce a new level 
of quality to your Visio diagrams. You’ve always been able to create great looking dia-
grams with Visio, but now you can ensure that your diagrams meet a minimum set of 
predefined conditions before you publish or distribute them.

Four Visio 2010 templates—Basic Flowchart, Cross Functional Flowchart, Microsoft 
SharePoint Workflow, and Business Process Modeling Notation—include predefined vali-
dation rule sets that you can run in diagrams created from those templates. You can also 
import existing rule sets into other diagrams. For example, you can add the flowchart 
rules to a Visio 2003 flowchart to improve its quality. You can also create your own rules 
and rule sets to validate diagrams.

Summary
There’s a lot to like about Visio 2010! This introduction has barely scratched the surface 
of some of the new features in the software. The exercises in this book will get you 
started with Visio 2010 and will give you hands-on experience with the best that Visio 
has to offer.
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Modifying the Display of the Ribbon
The goal of the Microsoft Office working environment is to make working with Office 
documents, including Microsoft Word documents, Excel workbooks, PowerPoint presen-
tations, Outlook e-mail messages, Access database tables, and Visio diagrams as intuitive 
as possible. You work with an Office document and its contents by giving commands 
to the program in which the document is open. All Office 2010 programs organize com-
mands on a horizontal bar called the ribbon, which appears across the top of each pro-
gram window whether or not there is an active document.

Ribbon tabs Ribbon groups

Commands are organized on task-specific tabs of the ribbon, and in feature-specific 
groups on each tab. Commands generally take the form of buttons and lists. Some appear 
in galleries. Some groups have related dialog boxes or task panes that contain additional 
commands. 

Throughout this book, we discuss the commands and ribbon elements associated with 
the program feature being discussed. In this topic, we discuss the general appearance of 
the ribbon, things that affect its appearance, and ways of locating commands that aren’t 
visible on compact views of the ribbon.

Dynamic Ribbon Elements
The ribbon is dynamic, meaning that the appearance of commands on the ribbon 
changes as the width of the ribbon changes. A command might be displayed on the ribbon 
in the form of a large button, a small button, a small labeled button, or a list entry. As 
the width of the ribbon increases or decreases, the size, shape, and presence of buttons 
on the ribbon adapt to the available space.

For example, when sufficient horizontal space is available, the buttons on the Review tab 
of the Word program window are spread out and you’re able to see more of the commands 
available in each group.
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Drop-down lists Large button Small labeled buttonsGallery

If you decrease the width of the ribbon, small button labels disappear and entire groups 
of buttons hide under one button that represents the group. Click the group button to 
display a list of the commands available in that group.

Small unlabeled button Group button

When the window becomes too narrow to display all the groups, a scroll arrow appears 
at its right end. Click the scroll arrow to display hidden groups.

Gallery list Scroll arrow

Changing the Width of the Ribbon
The width of the ribbon is dependent on the horizontal space available to it, which de-
pends on these three factors:

● The width of the program window Maximizing the program window provides the 
most space for ribbon elements. You can resize the program window by clicking 
the button in its upper-right corner or by dragging the border of a nonmaximized 
window.

Tip On a computer running Windows 7, you can maximize the program window by dragging 
its title bar to the top of the screen.
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● Your screen resolution Screen resolution is the size of your screen display ex-
pressed as pixels wide × pixels high. The greater the screen resolution, the greater 
the amount of information that will fit on one screen. Your screen resolution options 
are dependent on your monitor. At the time of writing, possible screen resolutions 
range from 800 × 600 to 2048 × 1152. In the case of the ribbon, the greater the 
number of pixels wide (the first number), the greater the number of buttons that 
can be shown on the ribbon, and the larger those buttons can be.

On a computer running Windows 7, you can change your screen resolution from 
the Screen Resolution window of Control Panel. You set the resolution by dragging 
the pointer on the slider.

● The density of your screen display You might not be aware that you can change 
the magnification of everything that appears on your screen by changing the 
screen magnification setting in Windows. Setting your screen magnification to 
125% makes text and user interface elements larger on screen. This increases the 
legibility of information, but means that less fits onto each screen.



xvi   Modifying the Display of the Ribbon

On a computer running Windows 7, you can change the screen magnification from 
the Display window of Control Panel. You can choose one of the standard display 
magnification options, or create another by setting a custom text size.

The screen magnification is directly related to the density of the text elements on 
screen, which is expressed in dots per inch (dpi) or pixels per inch (ppi). (The terms 
are interchangeable, and in fact are both used in the Windows dialog box in which 
you change the setting.) The greater the dpi, the larger the text and user interface 
elements appear on screen. By default, Windows displays text and screen elements 
at 96 dpi. Choosing the Medium - 125% display setting changes the dpi of text and 
screen elements to 120 dpi. You can choose a custom setting of up to 500% mag-
nification, or 480 dpi, in the Custom DPI Setting dialog box. The list allows you to 
choose a magnification of up to 200%. You can choose a greater magnification by 
dragging across the ruler from left to right.
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See Also For more information about display settings, refer to Windows 7 Step by Step 
(Microsoft Press, 2009), Windows Vista Step by Step (Microsoft Press, 2006), or Windows XP 
Step by Step (Microsoft Press, 2002) by Joan Lambert Preppernau and Joyce Cox.

Adapting Exercise Steps
The screen images shown in the exercises in this book were captured at a screen resolu-
tion of 1024 × 768, at 100% magnification, and the default text size (96 dpi). If any of 
your settings are different, the ribbon on your screen might not look the same as the 
one shown in the book. For example, you might see more or fewer buttons in each of 
the groups, the buttons you see might be represented by larger or smaller icons than 
those shown, or the group might be represented by a button that you click to display the 
group’s commands.

When we instruct you to give a command from the ribbon in an exercise, we do it in this 
format:

● On the Insert tab, in the Illustrations group, click the Chart button.

If the command is in a list, we give the instruction in this format:

● On the Page Layout tab, in the Page Setup group, click the Breaks button and 
then, in the list, click Page.

The first time we instruct you to click a specific button in each exercise, we display an im-
age of the button in the page margin to the left of the exercise step.
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If differences between your display settings and ours cause a button on your screen to 
look different from the one shown in the book, you can easily adapt the steps to locate 
the command. First, click the specified tab. Then locate the specified group. If a group 
has been collapsed into a group list or group button, click the list or button to display 
the group’s commands. Finally, look for a button that features the same icon in a larger 
or smaller size than that shown in the book. If necessary, point to buttons in the group to 
display their names in ScreenTips.

If you prefer not to have to adapt the steps, set up your screen to match ours while you 
read and work through the exercises in the book.
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Features and Conventions of 
This Book

This book has been designed to lead you step by step through all the tasks you’re most 
likely to want to perform in Microsoft Visio 2010. If you start at the beginning and work 
your way through all the exercises, you will gain enough proficiency to be able to cre-
ate and work with many types of Visio diagrams. However, each topic is self-contained. 
If you have worked with a previous version of Visio, or if you completed all the exercises 
and later need help remembering how to perform a procedure, the following features of 
this book will help you locate specific information:

●	 Detailed	table	of	contents	 Search the listing of the topics within each chapter.

●	 Chapter	thumb	tabs	 Easily locate the beginning of the chapter you want.

●	 Topic-specific	running	heads	Within a chapter, quickly locate the topic you want 
by looking at the running heads at the top of odd-numbered pages.

●	 Glossary	 Look up the meaning of a word or the definition of a concept.

●	 Detailed	index	 Look up specific tasks and features in the index, which has been 
carefully crafted with the reader in mind.

You can save time when reading this book by understanding how the Step by Step series 
shows exercise instructions, keys to press, buttons to click, and other information.

Convention Meaning
SET	UP This paragraph preceding a step-by-step exercise indi-

cates the practice files that you will use when working 
through the exercise. It also indicates any requirements 
you should attend to or actions you should take before 
beginning the exercise.

CLEAN	UP This paragraph following a step-by-step exercise pro-
vides instructions for saving and closing open files or 
programs before moving on to another topic. It also 
suggests ways to reverse any changes you made to 
your computer while working through the exercise.

1

2

Numbered steps guide you through hands-on exercises 
in each topic, as well as procedures in sidebars and 
expository text.
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Convention Meaning
See	Also This paragraph directs you to more information about 

a topic in this book or elsewhere.
Troubleshooting This paragraph alerts you to a common problem and 

provides guidance for fixing it.
Tip This paragraph provides a helpful hint or shortcut that 

makes working through a task easier.
Important This paragraph points out information that you need 

to know to complete a procedure.
Keyboard	Shortcut This paragraph provides information about an avail-

able keyboard shortcut for the preceding task.
Ctrl+B A plus sign (+) between two keys means that you must 

press those keys at the same time. For example, “Press 
Ctrl+B” means that you should hold down the Ctrl key 
while you press the B key.
Pictures of buttons appear in the margin the first time 
the button is used in a chapter.

Bold In exercises that begin with SET UP information, bold 
type displays text that you should type; the names of 
program elements, such as buttons, commands, win-
dows, and dialog boxes; and files, folders, or text that 
you interact with in the steps.
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Using the Practice Files
Before you can complete the exercises in this book, you need to copy the book’s practice 
files to your computer. These practice files, and other information, can be downloaded 
from here:

oreilly.com/catalog/9780735648876/

Display the detail page in your web browser and follow the instructions for downloading 
the files.

Important The Microsoft Visio2010 program is not available from this website. You should 
purchase and install that program before using this book.

The following table lists the practice files for this book.

Chapter File
Chapter 1: A Visual Orientation to  
a Visual Product

Size & Position_start.vsd

Chapter 2: Creating a New Diagram Autoconnect and Quick Shapes_start.vsd
Basic shapes_start.vsd

Chapter 3: Adding Sophistication to  
Your Drawings

Background Exercises_start.vsd
Corporate Diagram International_start.vsd
Corporate Diagram_start.vsd
International Office.jpg
Starfish.jpg
Text Exercises_start.vsd

Chapter 4: Drawing the Real World: 
Flowcharts and Organization Charts

HR Recuiting Flowchart_start.vsd
Org Chart Data_start.xlsx

Chapter 5: Adding Style, Color,  
and Themes

HR Recruiting Flowchart with labels_start.vsd
Org Chart by Hand with data_start.vsd
Org Chart via Wizard with data_start.vsd

Chapter 6: Entering, Linking to, and 
Reporting on Data

HR Process Data_start.xlsx
HR Process Map with data_start.vsd
HR Process Map_start.vsd

Chapter 7: Adding and Using Hyperlinks HR Process Map_start.vsd
Human Resources Policy Manual.docx
Sample PDF Document.pdf
Sample presentation.pptx
Sample Project file.mpp
Sample spreadsheet.xlsx
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Chapter File
Chapter 8: Sharing and Publishing  
Diagrams: Part 1

HR Process Map for Chapter08_start.vsd

Chapter 9: Drawing the Real World:  
Network and Data Center Diagrams

Network Diagram (Basic) with data_start.vsd
Network Diagram (Basic)_start.vsd
Network Diagram (Detailed)_start.vsd
Network Diagram (Organized)_start.vsd
Network Diagram with Rack_start.vsd
Network Equipment Data (Basic)_start.xlsx

Chapter 10: Visualizing Your Data Casino Floor.vsd
HR Process Map with data_start.vsd
Sales Proposal Process TaskMap.pdf

Chapter 11: Adding Structure to Your 
Diagrams

Containers, Lists and Callouts_start.vsd

Chapter 12: Creating and Validating  
Process Diagrams

HR Recruiting Flowchart Validation_start.vsd
RuleSets -- BPMN.html
RuleSets -- CFF.html
RuleSets -- Flowchart.html
RuleSets -- SharePoint Workflow.html
Theatre Ticketing Process_start.vsd
Theatre Ticketing with Subprocess_start.vsd
Visio 2007 Flowchart_start.vsd

Chapter 13: Sharing and Publishing 
Diagrams: Part 2

HR Process Map Save as Web2_start.vsd
Theater Ticketing Diagram_start.vsd

Appendix: Looking Under the Hood ShapeSheet_start.vsd

Companion Content
Bonus content for this book, including a list of all templates included with Visio 2010 and 
a selection of Visual Basic for Applications programs, can be found here:

http://aka.ms/648876/files

Please follow the directions for downloading.

http://aka.ms/648876/files
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Getting Support and Giving 
Feedback

Errata
We’ve made every effort to ensure the accuracy of this book and its companion content. 
If you do find an error, please report it on our Microsoft Press site: 

	 1.	 Go to www.microsoftpressstore.com.

	 2.	 In the Search box, enter the book’s ISBN or title.

	 3.	 Select your book from the search results.

	 4.	 On your book’s catalog page, find the Errata & Updates tab

You’ll find additional information and services for your book on its catalog page. If you 
need additional support, please send an email message to Microsoft Press Book Support 
at mspinput@microsoft.com.

Please note that product support for Microsoft software is not offered through the 
addresses above.

Getting Help with Visio 2010
If your question is about Visio, and not about the content of this Microsoft Press book, 
your first recourse is the Visio Help system. You can find general or specific Help infor-
mation by clicking the Help button (labeled with a question mark) located in the upper-
right corner of the Visio program window.

If your question is about Visio or another Microsoft software product and you cannot 
find the answer in the product’s Help system, please search the appropriate product 
solution center or the Microsoft Knowledge Base at:

support.microsoft.com

You can post questions and search previously answered questions at the Microsoft 
Answers community-based forums at:

answers.microsoft.com

www.microsoftpressstore.com
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In the United States, Microsoft software product support issues not covered by the 
Microsoft Knowledge Base are addressed by Microsoft Product Support Services. 
Location-specific software support options are available from:

support.microsoft.com/gp/selfoverview/

We Want to Hear from You
At Microsoft Press, your satisfaction is our top priority, and your feedback our most valu-
able asset. Please tell us what you think of this book at:

www.microsoft.com/learning/booksurvey

The survey is short, and we read every one of your comments and ideas. Thanks in advance 
for your input!

Stay in Touch
Let’s keep the conversation going! We’re on Twitter: http://twitter.com/MicrosoftPress.
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Your Companion eBook
The eBook edition of this book allows you to:

● Search the full text

● Print

● Copy and paste

To download your eBook, please see the instruction page at the back of this book.
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 4  Drawing the Real 
World: Flowcharts 
and Organization 
Charts

In this chapter, you will learn how to
✔ Select a flowchart type.
✔ Create flowcharts.
✔ Add labels to flowcharts.
✔ Understand and create swimlane diagrams.
✔ Understand organization charts.
✔ Build an organization chart by hand.
✔ Use the Organization Chart Wizard with existing or new data.
✔ Enhance org charts with pictures.

In the first three chapters, you learned many of the basic capabilities of Microsoft Visio 
2010. In this chapter, you will apply that knowledge to creating real-world diagrams. There 
is no better place to start than with the humble flowchart, because creating flowcharts is 
one of the most common tasks for which people use Visio. In fact, according to Microsoft, 
one-third of all Visio diagrams are based on templates from the flowchart category.

Whether the end goal is to diagram the logic of a current or future software module, or 
to document the way that a work procedure is, or could be, performed, Visio flowcharts 
are the standard. Visio is also used to create an alternative type of flowchart called a 
cross-functional flowchart or swimlane diagram.

Another common application for Visio is to create organization charts, often known 
as org charts. You can create org charts manually by dragging the intelligent organi-
zation chart shapes from the Visio stencil onto the drawing page, or you can run the 
Organization Chart Wizard to automate the work of creating your drawing.
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In this chapter, you will learn about different types of flowcharts and will create both 
conventional flowcharts and swimlane diagrams. You will also learn how to add text to 
Visio flowchart shapes. Finally, you’ll learn how to build an organization chart by hand as 
well as by using the wizard, and how to enhance organization charts with pictures.

Practice Files Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice files you’ll use to complete the 
exercises in this chapter are in the Chapter04 practice files folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.

Selecting a Flowchart Type
Visio provides different flowchart templates, depending on the edition that you use.

Visio Standard
Visio Standard 2010 includes three flowchart templates, as shown in the following graphic. 
You will work with the Basic Flowchart and Cross-Functional Flowchart templates in this 
chapter.

Visio Professional
Visio Professional 2010 includes the same three flowcharts as the Standard edition but 
also includes two additional flowchart templates: IDEF0 and SDL Diagram.

See Also For additional information about IDEF0, go to en.wikipedia.org/wiki/
IDEF0. For additional information about SDL, go to en.wikipedia.org/wiki/
Specification_and_Description_Language.
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Visio Premium
Visio Premium 2010 adds two workflow templates beyond those available with the 
Professional edition. You will learn more about the BPMN Diagram and Microsoft 
SharePoint Workflow templates in Chapter 12, “Creating and Validating Process 
Diagrams.”
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Vertical or Horizontal?

Should you draw your flowcharts with vertical (portrait) or horizontal (landscape) 
orientation? Vertical flowcharts, with tasks arranged from top to bottom, are prob-
ably more common, but there have always been advocates for the left-to-right, 
horizontal view.

One interesting note if you have created flowcharts with previous versions of Visio: 
the Visio 2010 Basic Flowchart template defaults to horizontal orientation, whereas 
previous versions presented a vertical view by default. Although this may frustrate 
people with a long-standing preference for the portrait view, there is some logic to 
this choice because computer screens have grown wider over the years.

Creating Flowcharts
In this exercise, you will create a new flowchart for a simple human resources recruiting 
process. The flowchart will have seven process steps and one decision.

SET UP Start Visio, or if it’s already running, click the File tab, and then click New. 
In the Template Categories section, click Flowchart, and then double-click the Basic 
Flowchart thumbnail. Save the new drawing as HR Recruiting Flowchart. 

 1. Drag a Start/End shape from the Basic Flowchart Shapes stencil onto the draw-
ing page.

 2. Click once on the Process shape in the stencil to select it.

 3. Point to the start shape you added to the drawing page, and click the right-facing 
blue triangle that appears in order to add a Process shape from the pop-up Quick 
Shapes menu.

See Also For a refresher on using Quick Shapes, see “Using AutoConnect and Quick 
Shapes” in Chapter 2, “Creating a New Diagram.”



 Creating Flowcharts  115

 4. Use the same technique to add three more Process shapes to the page.

 5. Drag a Process shape onto the drawing page. Then use the Dynamic Grid to posi-
tion the new process shape below the left-most process shape.

See Also For more information about the Dynamic Grid in Visio, see “Using Basic Shapes 
and the Dynamic Grid” in Chapter 2.

 6. From the Quick Shapes menu, add the following four shapes:

❍ Another Process shape to the right of the one from Step 5.

❍ A Decision diamond to the right of the previous process shape.

❍ Another Process shape to the right of the decision diamond.

❍ A Start/End shape to the right of the final process shape.

At this point, the flowchart is nearly complete with the exception of two connec-
tors: one that links the end of the first row to the beginning of the second row, and 
one that links the decision diamond back to a previous step in the flowchart.
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 7. On the Home tab, in the Tools group, click the Connector button, and then move 
the cursor near the last shape in the first row.

Notice two things:

❍ The cursor has changed from a white arrow with a black outline (the Pointer 
Tool) to a black arrow with a connector beneath it (the Connector Tool).

❍ When you move the Connector Tool near a shape, small blue Xs, called connec-
tion points, appear at various places on the shape.

 8. Click the connection point on the right of the process shape, and then drag to the 
leftmost connection point on the first process shape in the second row.

 9. Click the connection point on the bottom of the decision diamond, and then drag 
to the connection point on the bottom of the process shape two shapes to the left.

 10. On the Home tab, in the Tools group, click the Pointer Tool button to return the 
cursor to its normal operating mode.

 11. Drag a Document shape to just below the last process shape in the top row.

Connector

Pointer Tool
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Important Do not drop the document shape on the connector line or Visio will break 
the connector in two and connect your document shape to both lines. This feature is 
called AutoAdd and is described in Chapter 2.

Notice that Visio automatically moved the connector line out of the way, which is 
generally good. However, because the new positioning isn’t desirable for your flow-
chart, you will rearrange some of the shapes in the next step.

 12. Drag a bounding box around all of the shapes in the bottom row. Then hold down 
the Shift key while you drag that row down to make more room.

Tip Holding down the Shift key constrains Visio to moving the selected shapes only 
vertically or horizontally, whichever is the first direction you move the cursor.

Once again, Visio will reposition the connector line to accommodate the new loca-
tion of the bottom row.

 13. Click the blue AutoConnect arrow under the upper-right process shape to connect 
it to the document shape.

The layout of your flowchart is now complete.

CLEAN UP Save your changes to the HR Recruiting Flowchart drawing but leave it 
open if you are continuing with the next exercise.
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Adding Labels to Flowcharts
In the preceding exercise, you learned the mechanics of creating a flowchart, but your 
diagram isn’t very useful yet because your shapes have no labels, data, or identifying 
information. 

See Also For information about adding data to your shapes, see Chapter 6, “Entering, Linking 
to, and Reporting on Data.”

In this exercise, you will add text labels to your flowchart shapes.

SET UP If you completed the preceding exercise, continue working with the HR 
Recruiting Flowchart drawing. If not, you need the HR Recruiting Flowchart_start 
drawing located in the Chapter04 practice file folder to complete this exercise. Open 
the drawing in Visio and save it as HR Recruiting Flowchart.

 1. Double-click the start shape in the upper-left of your diagram, and then type 
Hiring need reported.

 2. Double-click the first process shape in your flowchart, and then type Log hiring 
request.

Tip You can also add text to most Visio shapes by clicking once to select the shape and 
then starting to type. That technique will work with the flowchart shapes.

 3. Continue from left to right across the top row and add the following labels to the 
process shapes:

❍ Prepare job description and screening questions

❍ Advertise open job

❍ Interview candidates

 4. Double-click and type the following text into the five shapes in the bottom row, 
moving from left to right:

❍ Select a candidate

❍ Make job offer

❍ Candidate accepts?

❍ Hire candidate

❍ End
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 5. Double-click the connector between the Candidate accepts? shape and the Hire 
candidate shape and type Yes.

 6. Double-click the connector between the Candidate accepts? shape and the Select 
a candidate shape and type No.

 7. Add a text box to the top of the page and type Human Resources Recruiting 
Process as a title for the flowchart.

 8. Select the title text box, and then set the font size to 24 pt. and make the text 
bold.

Your finished flowchart should look something like the following graphic.

CLEAN UP Save your changes to the HR Recruiting Flowchart drawing, and then 
close it.

Understanding Swimlane Diagrams
Swimlane diagrams are a popular variation on flowcharts because they correct one sig-
nificant failing of flowcharts: very few flowcharts show who is responsible for each of the 
steps or who makes the key decisions.

A swimlane diagram, on the other hand, is specifically organized by role, function, or de-
partment. Each process step is placed into a specific lane based on who does the work or 
who has the responsibility for that process step. For example, a swimlane diagram with a 
focus on roles might include lanes marked Accounts Payable Clerk, Accounting Supervisor, 
and Chief Financial Officer. Similarly, a department-focused swimlane drawing might 
show lanes labeled Sales, Marketing, Order Processing, and Manufacturing.
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Swimlane diagrams are also known as cross-functional flowcharts because they show 
work steps as they cross the functional boundaries in an organization. In this context, in-
dividual swimlanes are usually referred to as functional bands.

Regardless of the terminology, swimlane diagrams can be laid out with horizontal or 
vertical lanes. Using Visio, you can choose the orientation you prefer, as you’ll see in the 
exercise in the following section.

Tip Some Visio templates employ additional software, outside of Visio itself, to perform 
their functions. The cross-functional flowchart diagram is an example of this type of Visio 
add-in. And, as is typical for this type of add-in, cross-functional flowcharts present a custom 
tab on the ribbon. The ribbon shown in the following graphic includes the Cross-Functional 
Flowchart tab.

Creating Swimlane Diagrams
In the preceding exercises, you created a flowchart of a human resources recruiting pro-
cess. However, the flowchart does not indicate who is responsible for each task.

In this exercise, you will create a swimlane diagram of the same process. In doing so, you 
will organize the work steps into role-based lanes to make responsibilities clear.

SET UP Click the File tab, and then click New.

 1. In the Template Categories section, click Flowchart, and then double-click the 
Cross-Functional Flowchart thumbnail. The orientation selection dialog box 
opens.
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Tip If you have previously selected a default orientation, this dialog box will not appear 
again. However, you can still change both the orientation of a single diagram and the 
default for future diagrams. On the Cross-Functional Flowchart tab, in the Arrange 
group, click the Orientation button and make your selection.

 2. Click OK to select a Horizontal layout. The swimlane add-in places a title band and 
two swimlanes onto the drawing page.

 3. On the Cross-Functional Flowchart tab, in the Insert group, click the Swimlane 
button twice to add two more lanes to your diagram.

Tip There are three other ways to add swimlanes, each of which is useful at various 
times:

● Right-click the header of an existing lane, and Visio offers you a choice of adding a 
new swimlane above or below the one you’ve selected.

● Drag a Swimlane shape from the stencil and drop it on top of an existing lane. 

● Point to the boundary between lanes, with the cursor just outside the swimlane 
structure, and click the blue insertion triangle. (You will learn about the final 
method in Chapter 11, “Adding Structure to Your Diagrams.”)

You’ve probably already figured this out, but swimlane diagrams are so named because 
they resemble a swimming pool viewed from above.

 4. Double-click the Title bar and type Human Resources Recruiting Swimlane 
Diagram.

 5. Double-click the Function title bar for the top swimlane and type Recruiter.

 6. Type HR Admin as the title for the second swimlane, Hiring Manager for the third 
swimlane, and Candidate for the bottom swimlane.

Swim Lane
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 7. Drag a Start/End shape from the Basic Flowchart Shapes stencil onto the draw-
ing page and use the Dynamic Grid to position it in the Hiring Manager lane.

 8. Click the start/end shape and type Hiring need reported.

 9. Drag a Process shape into the HR Admin lane, dropping it to the right of the 
start/end shape, and then type Log hiring request.

 10. On the Home tab, in the Tools group, click the Connector button, and then draw 
a connector from the top of the Hiring need reported shape to the left side of 
the Log hiring request shape.

Connector
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 11. Drag a Process shape into the Hiring Manager lane, and then type Prepare job 
description and screening questions.

 12. Use the Connector tool to link the previous process step to your new task.

 13. Continue adding flowchart shapes to your diagram using the information in rows 
4-10 of the following table. (Rows 1-3 represent the shapes you’ve already added.) 
As you add each shape, draw a connector from the previous row’s shape to the 
new shape.

Shape Swimlane Shape text
1 Start/End Hiring Manager Hiring need reported
2 Process HR Admin Log hiring request
3 Process Hiring Manager Prepare job description and 

screening questions
4 Process HR Admin Advertise open job
5 Process Recruiter Interview candidates
6 Process Hiring Manager Select a candidate
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Shape Swimlane Shape text
7 Process Recruiter Make job offer
8 Decision Candidate Candidate accepts?
9 Process Recruiter Hire candidate
10 Start/End Hiring Manager End

 14. Add a connector from the bottom of the Candidate accepts? shape to the bottom 
of the Select a candidate shape.

 15. Click the connector from the Candidate accepts? shape to the Hire candidate 
shape and type Yes.

 16. Click the connector from the Candidate accepts? shape to the Select a candidate 
shape and type No.

Your swimlane diagram should look something like the following graphic. It’s un-
likely that your drawing will look exactly like this one because you probably made 
different decisions about placing and connecting shapes. However, after you have 
the general placement and connectivity correct, you can adjust and tweak your 
diagram to make it look the way you’d like.

If you think your diagram is too crowded, realize that the cross-functional flow-
chart template used the default paper size for your region. If you need more 
space, you can increase the drawing page size as described in Chapter 3, “Adding 
Sophistication to Your Drawings.”

CLEAN UP Save the drawing as HR Recruiting Swimlane, and then close it.
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One final note about the Visio 2010 take on cross-functional flowcharts: although the 
end result looks very much as it has in previous versions of Visio, the underlying struc-
ture is very different. In fact, structure is the operative word in the previous sentence. In 
Visio 2010, each swimlane is a container, and the overall framework is a list. Containers 
and lists are key components of Visio 2010 structured diagrams and are described in 
Chapter 11.

Understanding Organization Charts
An organization chart is typically used to reflect the structure of an organization by 
showing who reports to whom. The Visio organization chart solution is based on a hier-
archical model in which each employee has one boss. Consequently, it doesn’t lend itself 
to organizations that use a matrix or other nonhierarchical structure. However, it is well-
suited for most organizations.

Some org charts are simple and unadorned, showing just names and titles. Other org 
charts are more sophisticated and might display additional departmental or personal 
information, including photographs. Like most Visio templates, the org chart template 
includes a set of intelligent shapes. However, the org chart shapes are assisted by add-
in software that is packaged with Visio. The combination of the two simplifies the cre-
ation of org charts by handling nearly all of the sizing and spacing chores when you do 
things like drop an employee shape on top of a manager shape. In addition, the add-in 
software includes a wizard that you can use to import organization data from Microsoft 
Excel or other data sources.

The org chart add-in also displays an add-in tab on the Visio ribbon whenever an org 
chart is the active drawing.

See Also For more information about add-in tabs, see “Understanding Add-in Tabs” in 
Chapter 1, “A Visual Orientation to a Visual Product.”

In the sections that follow, you will create a simple org chart manually and a more com-
plex org chart by using data in an Excel workbook.
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Building an Organization Chart by Hand
You will use the Organization Chart Wizard in the next two exercises, but it’s important 
to understand first how easy it is to create org charts by hand.

In this exercise, you will create a new org chart by dragging shapes onto the page and 
using the org chart template’s auto-positioning features. You will also enter data for each 
shape in the chart.

SET UP  Click the File tab and then click New. In the Template Categories section, 
click Business, and then double-click the Organization Chart thumbnail. Save the new 
drawing as Org Chart by Hand. 

Tip  The only difference between the template called Organization Chart and the one 
called Organization Chart Wizard is that the latter automatically starts a wizard when 
you open a new document. If you select the Organization Chart Wizard by mistake for 
this exercise, just cancel the wizard and you can continue.

 1. Drag the Executive shape from the Organization Chart Shapes stencil to the top 
center of the drawing page.

The org chart add-in presents an animated dialog box showing how to add addi-
tional shapes to the chart unless you have previously turned it off. You can select 
the check box in the lower-left of the dialog box to suppress future display of the 
animated help.

 2. With the shape still selected, type Magnus Hedlund. Then press Enter and type 
President on the second line.

 3. Drag a Manager shape onto the Magnus Hedlund shape. Then type Magdalena 
Karwat, press Enter, and type Vice President. Notice that the org chart software 
automatically positions the new shape below the Hedlund shape.
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 4. Repeat Step 3 and notice that the org chart add-in has positioned the second 
manager shape to the side of the first one. With the new shape still selected, type 
Allison Brown, press Enter, and then type Vice President.

 5. Drag one more Manager shape onto the Hedlund shape. Type Giorgio Veronesi, 
press Enter, and then type Vice President.

 6. Drag two Position shapes onto the Giorgio Veronesi shape, then type Janet 
Schorr into the first one and Reina Cabatana into the second.

 7. Drag one Position shape onto the Magadalena Karwat shape and type Filip 
Rehorik.

The org chart’s shape placement mechanism has hidden part of the Reina Cabatana 
shape behind the Filip Rehorik shape.
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 8. On the Org Chart tab, in the Layout group, click the Re-Layout button to solve 
the problem.

Tip There may be times when you don’t like the changes made by the re-layout 
function. If that’s the case, simply press Ctrl+Z or click the Undo button on the Quick 
Access Toolbar. No matter how extensive the changes, a single undo will return the 
diagram to its previous layout.

 9. Drag a Consultant shape onto the Magadalena Karwat shape and type Sandeep 
Kaliyath. Notice that consultant shapes have a dash-dot outline.

 10. Drag a Vacancy shape onto the Allison Brown shape and type Open. Notice that 
vacancy shapes have a dotted outline.

 11. Drag an Assistant shape onto the Allison Brown shape and type Gabe Frost.

 12. Drag an Assistant shape onto the Giorgio Veronesi shape and type Yan Li.

 13. Drag an Assistant shape onto the Magnus Hedlund shape and type Cassie Hicks.

 14. On the Org Chart tab, in the Layout group, click the Re-Layout button.

Tip You can also initiate page layout by right-clicking anywhere on the background of 
an org chart page and selecting Re-layout from the context menu.

The org chart add-in has rearranged your drawing to position all of your shapes. 
Take note of the dash-dot consultant, the dotted vacancy, and the placement of 
the assistant shapes under Magnus Hedlund, Allison Brown, and Giorgio Veronesi.

At this point, you’ve built a reasonably sophisticated organization chart by doing 
little more that dragging shapes and typing text.

Re-Layout
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CLEAN UP Save your changes to the Org Chart by Hand drawing, and then close it.

Altering Org Chart Shapes

Whether you create an organization chart manually, as you’ve just done, or automat-
ically using the wizard, you might want to modify the appearance and attributes of 
the org chart shapes after they’re on the page. The Visio organization chart add-in 
provides a number of easy ways to make changes.

Type
You can right-click any org chart shape to change its type. For example, in the or-
ganization chart you created in the preceding exercise, you identified a vacancy 
in Allison Brown’s group, symbolized by a dotted outline around the position box. 
When Allison hires a person to fill that vacancy, simply right-click the vacant posi-
tion shape, click Change Position Type, click Position, and then click OK.

Appearance
You can change the appearance of the org chart shapes by adding a dividing line 
between the position and the title. To do so, select some or all of the shapes on the 
page, right-click any of the shapes, and then click Show Divider Line.



130   Chapter 4 Drawing the Real World: Flowcharts and Organization Charts

You can also affect the appearance of org chart shapes by showing additional 
data on each shape. For examples of what is possible, on the Org Chart tab, in the 
Organization Data group, click the Display Options button. In the resulting Options 
dialog box, click the Fields tab to see your choices.

On the other tabs in this dialog box, you can change the size and spacing of org 
chart shapes and the size and formatting of the text.

See Also You can change the appearance of an organization chart quite dramatically by 
applying themes. For details and examples, see “Applying Themes to Your Diagrams” in 
Chapter 5, “Adding Style, Color, and Themes.”

Using the Organization Chart Wizard with  
Existing Data

What if you already have your organization data available in electronic form? For ex-
ample, you might have:

● An Excel workbook that already contains names and reporting information.

● A Human Resources or Enterprise Resource Planning (ERP) system that can gener-
ate an Excel file or a text file.

● Organization data in a Microsoft Exchange Server directory.

● Organization data in a Microsoft Access, dBase, or other database.

In all of those situations, the org chart wizard can help you to create your chart.

In this exercise, you will use data in an Excel workbook to build an organization chart.



 Using the Organization Chart Wizard with Existing Data   131

SET UP You need the Org Chart Data_start workbook located in the Chapter04 
practice file folder to complete this exercise.

 1. Start Excel, open the Org Chart Data_start workbook, and save it as Org Chart 
Data. While the workbook is open, look at the data that will be used in this ex-
ercise. In particular, notice that there are columns for Name, Title, Reports To, 
Employee Number, and Extension.

 2. Close Excel, and then start Visio.

 3. In the Template Categories section, click Business, and then double-click the 
Organization Chart Wizard thumbnail. 

Tip The only difference between the template called Organization Chart Wizard and the 
one called Organization Chart is that the former automatically starts a wizard when you 
open a new document. If you select Organization Chart by mistake for this exercise, just 
click the Import button in the Organization Data group on the Org Chart tab to launch 
the wizard.

The first page of the wizard appears.
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 4. Click Next. The data source type page appears.

 5. Click A text, Org Plus (*.txt), or Excel file, and then click Next. The file selection 
page appears.

 6. Click the Browse button on the file selection page, and then, in the resulting file 
open dialog box, navigate to the Org Chart Data workbook. After selecting the 
correct file, click the Open button. 

The file name you selected appears in the Locate The File That Contains Your 
Organization Information box.

 7. Click Next. There is a slight pause as Visio opens and reads the data in your 
spreadsheet. 

The Organization Chart Wizard uses the column names, if any, in your spreadsheet 
to determine which columns hold the name and reporting structure information. It 
displays the column names that seem to be the best match in the next wizard page.
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Because the Org Chart Data workbook contains columns called Name and Reports 
To, the assumptions made by Visio are correct as shown. If the assumptions are not 
correct, click the arrows to the right of Name and Reports To in order to select the 
correct columns. 

Notice you can specify that a separate column contains employees’ first names, if 
that is the case.

 8. Click Next.

The next Organization Chart Wizard page provides an opportunity for you to se-
lect which employee data will be displayed on each shape in the chart. The wizard 
assumes that you want to display the name and title fields, so those fields are pre-
selected on the right side of the page.
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Tip You can control the vertical positioning of the data fields you’ve chosen with the 
Up and Down buttons below the Displayed Fields section of the page. The pane on the 
left side of the page provides a live preview of the data as it will be displayed in the org 
chart.

 9. In the Data file columns section of the page, click Extension, and then click the 
Add button to move it to the Displayed fields section. Finally, click Next.

On the wizard page that appears, you determine which spreadsheet data, if any, 
should be stored in each organization chart shape. This is a separate and unrelated 
decision from the one on the previous page. You can still display data on the org 
chart shapes even if you don’t store data in the shapes. 

Tip The primary reason to store data in org chart shapes is to allow you to run reports 
or use the data in other ways without the need to revert to your original data source.

 10. To add all fields to the shape, hold down the Shift key while clicking Extension, 
which selects everything in the Data file columns section, click Add, and then 
click Next.

Tip You can use the standard Windows conventions for selecting multiple items in the 
Data File Columns section:

● Hold down Shift and click to select everything from the current selection up to 
and including the item you click.

● Hold down Ctrl and click to select noncontiguous items.

On the final wizard page, you can choose among some of the Organization Chart 
Wizard’s powerful layout options. 
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Accepting the default selection of I Want The Wizard To Automatically Break My 
Organization Chart Across Pages lets the wizard figure out how much to fit on each 
Visio page. The <Top Executive> option tells Visio to select the person who doesn’t 
report to anyone else as the top shape on the first page of the org chart. If you 
prefer to select a specific person (like a department head), you can click the arrow 
to choose anyone in your list.

Clicking I Want To Specify How Much Of My Organization To Display On Each Page 
takes you to a wizard page not shown here, and allows you to control more directly 
how much to fit on each org chart page.

The Hyperlink Employee Shapes Across Pages check box specifies whether the wiz-
ard should add hyperlinks when org charts consist of multiple pages. For example, 
if a manager’s direct reports don’t fit on the page with the manager, the wizard 
will leave the manager shape on the original page and also place it on a subse-
quent page along with that manager’s direct reports. A check mark in this option 
tells Visio to add links in both manager shapes, making page-to-page navigation 
simpler.

The Synchronize Employee Shapes Across Pages check box also applies to the sce-
nario described in the preceding paragraph. A check mark in this option tells Visio 
to update the second shape if you change the data in the first one.

 11. Click Finish. The completed organization chart appears in the Visio drawing 
window.
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Tip The org chart wizard correctly connects each group of people to its respective boss, 
but you cannot control where the wizard places people on the page. You can relocate 
people and groups after the wizard has created the diagram; you just can’t control how 
the wizard does the initial placement.

 12. To finalize your organization chart, drag the Title/Date shape from the stencil into 
the upper-left portion of the drawing page.

 13. Double-click the Company Name text box and replace Company Name with Trey 
Research. The resulting organization chart should look like the following graphic.

The wizard has chosen one particular style and layout for your organization chart. 
However, you can experiment with more than a dozen built-in layouts to change 
the look of your chart as described in the following sidebar.

CLEAN UP Save your drawing as Org Chart using Wizard and then close it. 
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Altering Org Chart Layout

Although the org chart wizard has used a default layout for your chart, you can 
change the layout, move shapes and groups of shapes, and hide parts of the chart.

Rearrange
You can change the layout of an org chart by using more than a dozen predefined 
layouts supplied with Visio. On the Org Chart tab, in the Layout group, click 
Horizontal, Vertical, or Side By Side to select from a variety of options.

     

As an alternative, right-click any shape with subordinates, and then click Arrange 
Subordinates. Visio opens a dialog box showing all of the built-in layouts.

Tip If you don’t like the results of any re-layout operation—no matter how radical the 
changes—you can restore the previous layout with a single undo.
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Move
You can adjust the layout of an organization chart by moving shapes or groups of 
shapes left/right or up/down. Look for the Move buttons in the Arrange group on 
the Org Chart tab. For example, in the completed Org Chart using Wizard drawing 
from the preceding exercise, select the vice president named Christian Hess, and 
then click the Move Left/Up button to see the effect.

Hide
If you want to hide some sections of your org chart, click the Hide Subordinates 
or Show Subordinates options on a shape’s shortcut menu or the Show/Hide 
Subordinates button in the Arrange group on the Org Chart tab.

Using the Organization Chart Wizard with New Data
If your organization data is not in a format that Visio can read and you would like to type 
it into a spreadsheet but don’t want to start from scratch, the Organization Chart Wizard 
can create a preformatted spreadsheet for you.

In this exercise, you will use the Organization Chart Wizard to create an Excel workbook 
into which you will enter your organization data.

SET UP Click the File tab, and then click New. In the Template Categories section, 
click Business, and then double-click the Organization Chart Wizard thumbnail. 

 1. On the first page of the Organization Chart Wizard, click Information that I 
enter using the wizard.

Notice that the description text for this option confirms that you will be creating a 
new data source.
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 2. Click Next. The file type selection page appears.

 3. On the file type selection page, click Excel, and then click the Browse button. In 
the resulting dialog box, select a folder in which to save the file, type Org Chart 
Data via Wizard in the File name box, and then click the Save button.

The selected file name appears in the New File Name box on the next wizard page.

 4. Click Next. Visio instructs you to type your data over the sample data provided in 
the Excel workbook it has created.

 5. Click OK. Excel opens to display the formatted workbook. As shown in the follow-
ing graphic, notice that each column heading includes a comment with instructions 
for entering data in that column.
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 6. Ordinarily, you would type your data into the worksheet at this point; however, for 
this exercise you will use the sample data, so just close Excel.

Important Closing the worksheet isn’t sufficient; you must close the Excel application.

When you close Excel, Windows returns the focus to Visio, where you will see the 
final page of the Organization Chart Wizard.

 7. Click Finish to display your org chart.

CLEAN UP Save the sample file if you want to keep it.
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Enhancing Org Charts with Pictures
Visio 2010, like previous versions, gives you the option to add images to organization 
chart shapes. You can right-click a shape to add a picture or you can click the buttons in 
the Picture group on the Org Chart tab.

However, Visio only allows you to add or delete pictures one shape at a time. If you 
would like to add pictures to multiple shapes at once, check out an article and code 
sample provided by Visio MVP John Goldsmith at visualsignals.typepad.co.uk/vis-
log/2008/06/linking-org-chart-images.html.

An Unconventional Use for Organization Charts

Occasionally, you find a use for a Visio template that its designers might not have 
envisioned. The author of this book and another Visio expert did exactly that with 
the org chart wizard by using it to display the folder structure on a Windows com-
puter. After all, groups of people and folders on a disk drive are both organized 
hierarchically, so it seemed like a logical thing to do.

See Also To read an article about viewing the Windows disk drive as an “organization 
chart,” go to www.experts-exchange.com/viewArticle.jsp?articleID=2802.

Key Points
● Creating flowcharts is one of the most common uses for Visio. The built-in tem-

plates make it very easy for you to create both conventional flowcharts and swim-
lane diagrams.

● Swimlane diagrams, also known as cross-functional flowcharts, offer one key advan-
tage over regular flowcharts: each process step resides in a swimlane that identifies 
which role, department, or function is responsible for that step.

● You can create organization charts manually by dragging shapes from the org 
chart stencil onto the drawing page.

● The Organization Chart Wizard automates most of the creation of org charts by 
letting you import data from Excel spreadsheets, text files, and databases. In addi-
tion, the wizard can provide you with a preformatted spreadsheet that you can use 
to enter your organization’s data prior to running the wizard. 
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 6  Entering, Linking to, 
and Reporting on 
Data

In this chapter, you will learn how to
✔ Understand shape data.
✔ Edit shape data.
✔ View and change shape data attributes.
✔ Create new shape data fields.
✔ Link diagrams to external data.
✔ Refresh all or selected data in linked diagrams.
✔ Schedule data refresh.
✔ Link data to shapes automatically.
✔ Run a predefined report.
✔ Create a new report.
✔ Modify an existing report.

One of the most significant ways you can add value to your Microsoft Visio drawings is 
to store relevant data in the shapes on the drawing page. Although this capability has 
been a part of Visio since the beginning, Visio 2010 and Visio 2007 have added a signifi-
cant level of sophistication to the program’s ability to import, store, manipulate, visual-
ize, and report on critical business data.

In this chapter, you will discover ways to make your drawings even more valuable by 
creating data-driven diagrams. You will learn how to use, create, and edit shape data 
fields. You will also learn techniques for linking shapes in a Visio drawing to data stored 
in spreadsheets, databases, and other sources. Finally, you will learn to extract data from 
a Visio diagram by creating, modifying, and running reports.
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Practice Files Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice files you’ll use to complete the 
exercises in this chapter are in the Chapter06 practice files folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.

Understanding Shape Data
Many Visio shapes contain data fields, referred to collectively as shape data, that you 
can use to quantify and describe various properties of the shape. 

Tip The data fields that are called shape data in Visio 2010 and Visio 2007 were called Custom 
Properties in Visio 2003 and earlier. 

Visio 2010 supports eight types of shape data:

● String Free-form text

● Number Any numeric data; can be restricted to integers or a specific number of 
decimal places

● Fixed List A drop-down list from which users can make a selection; users cannot 
add additional values to the list

● Variable List A drop-down list from which users can make a selection; users can 
add additional values to the list by typing in the text box

● Duration Time value expressed in one of five time units supported by Visio: sec-
onds (es.), minutes (em.), hours (eh.), days (ed.), weeks (ew.); users enter a number 
followed by one of the time unit abbreviations shown

● Date Calendar date; users can either type a date or use a drop-down calendar to 
select a date

● Currency Currency value in currency units based on user’s Region and Language 
settings in Windows

● Boolean True or False

Viewing Shape Data
To view the shape data for any Visio object, right-click the shape, and click Data, which 
displays the data submenu. Then click Shape Data on the submenu.
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The Shape Data window typically appears somewhere within the main Visio window, 
usually in whatever position it was located the last time it was opened. The following 
graphic shows the data associated with a pump/motor 1 shape from the Fluid Power 
template in the Engineering template that is provided with Visio.

You can position the floating Shape Data window (shown on the left) wherever you 
would like it. Note that you can also resize the window or dock it in a fixed position by 
dragging it to an edge of the drawing window (shown in the center).

Tip The pushpin button in the docked window lets you turn AutoHide on or off for the 
docked window. If you turn AutoHide on, the window “rolls up” into the header when you’re 
not using it (shown on right).

      

Tip If the Shape Data window is already open when you right-click a shape, click Data, and 
then click Shape Data, Visio will close it. This may not be what you expect, especially if you 
didn’t notice that the window was already open and can’t figure out why it didn’t appear. 

If you look closely at the following two graphics, you’ll notice a subtle difference. It turns 
out that the Shape Data menu entry is actually a toggle that alternately shows and hides the 
window. In the graphic on the left, the window is closed so the icon to the left of Shape Data 
looks normal. However, in the one on the right, the icon is highlighted, indicating that the 
window is open.
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Other Ways to View Shape Data

Because shape data is so vital to Visio diagrams, there are several additional ways 
to view a shape’s data.

When you right-click some shapes, you can click Properties instead of Data. 
Although the Properties menu entry usually opens the same Shape Data window 
as the Data submenu technique, in some Visio templates, it opens a Shape Data 
dialog box instead. Although their appearance is a bit different, you can edit data 
in either one.

Tip The Properties entry is usually at the very bottom of the context menu.

For example, compare the following Shape Data dialog box for the Fluid Power 
pump/motor 1 with the corresponding Shape Data window, shown previously.

You can also open the Shape Data window from the Visio ribbon. On the Data tab, 
in the Show/Hide group, select the Shape Data Window check box.
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Editing Shape Data
After you have the Shape Data window open, you can change a shape’s data. As you do 
so, you’ll notice that some shape data fields behave differently than others. Visio enforces 
various rules based on the data type and formatting applied to each shape data field.

See Also For a list of the shape data types supported by Visio, see “Understanding Shape 
Data” earlier in this chapter.

As a simple example, you cannot enter text into a number or currency field. Similarly, 
Visio prevents you from entering anything other than a number and one of the five valid 
time unit abbreviations in a duration field.

In this exercise, you will edit some of the data associated with the Human Resources 
Recruiting Process you worked with in Chapter 4, “Drawing the Real World: Flowcharts 
and Organization Charts.” There are two differences between this map and the one from 
Chapter 4: the spacing between shapes has been expanded to open up the drawing; and 
additional shapes have been added to represent a database and several documents.

SET UP You need the HR Process Map_start drawing located in the Chapter06 
practice file folder to complete this exercise. Open the drawing in Visio and save it as 
HR Process Map. Then open the Shape Data window.

 1. Click on the shape labeled Log hiring request. Its data appears in the Shape Data 
window.

 2. To see an example of data validation based on field type, type abc into the Cost 
field, and then press either the Tab or Enter key to move to the next field.

Visio displays an error dialog box, indicating that your entry is not valid for this 
field because the Cost field expects a currency entry.

 3. Click OK to close the error dialog box.

 4. Type 5 and then press either the Tab or Enter key to move to the next field.
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Tip Because the copy of Windows on which these graphics were made uses United 
States Region and Language settings, the currency amount appears in dollars. Your 
computer will display currency values based on your regional settings.

 5. Type 101 in the Process Number field.

 6. Press either the Tab or Enter key to move to the Owner field, and then type John 
Smith.

 7. Click in the Start Date field. Notice that a browse button appears in the right end 
of the field.

Tip In a Visio date field, you can either type a date or use the calendar field browse 
button to select a date.

 8. Click the calendar field browse button and click a date in the pop-up calendar. The 
calendar closes and the selected date appears in the Shape Data window.

 9. Click in the Status field. Notice that a down-arrow appears in the right end of the 
field. This is an example of a Visio list field.
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 10. Click the arrow to reveal the predefined choices for this list.

 11. Click In Progress in the list.

Tip Visio supports two types of list fields: fixed lists and variable lists. In a fixed list field, 
you must select an entry from the list. In a variable list field, you have the option to 
select one of the list entries, or you can type your own text into the field if you prefer. 
If you type your own text, it gets added to the bottom of the list. The Status field in the 
preceding graphic is an example of a variable list field, so you can either select or type 
an entry in the field.

You can continue to enter or edit data for this process step, or you can select a 
different shape and edit its data.

CLEAN UP Save your changes to the HR Process Map drawing but leave it open if 
you are continuing with the next exercise.

Tip Though it is not advertised in any obvious way, you can edit data for more than one shape 
at a time. If you select multiple shapes before opening the Shape Data window, the changes 
you make will be applied to all selected shapes. This feature can be very powerful or very 
destructive, so it pays to be cautious.

Note that if you do select multiple shapes prior to opening the Shape Data window, you will 
only see the fields that all selected shapes have in common.

Viewing Shape Data Attributes
When you want to add data fields to a Visio shape, you need to open the Define Shape 
Data dialog box. To do so, right-click a shape, point to Data, and then click Define 
Shape Data.
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Tip You can also open the Define Shape Data dialog box by right-clicking anywhere in the 
Shape Data window and then clicking Define Shape Data.

The Define Shape Data dialog box looks like one of the following two samples. The one 
on the left appears for most Visio users. The one on the right appears if you are running 
Visio in developer mode, and offers several additional options.

See Also For information about developer mode, see the Appendix.

   

In both variations of the dialog box, notice that each data field has multiple attributes:

● Label Field name

● Type One of the eight types described in “Understanding Shape Data” earlier in 
the chapter

● Format Determines how data entered by the user will be presented; different field 
types have different format options
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● Value The data value entered when a shape was defined or entered by the user

● Prompt Tooltip text that appears when the user points to the shape’s name in the 
Shape Data window

In developer mode, you will see the additional attributes described in the following list. 
Although some of them are primarily for use by programmers, one or two may be of 
value even if you are not a programmer:

● Name An internal name used by Visio programmers; can be the same as Label 
except that Name cannot contain spaces or most special characters (an underscore 
character is OK).

● Sort key Visio uses the alphanumeric value in this field to determine the sequence 
in which fields will be presented in the Shape Data window.

Important Visio treats the contents of the Sort key field as text even if you enter a 
number, which means that it arranges fields based on alphabetic sequence rather than 
numeric sequence. For example, if field A has a sort key of “1”, field B has a sort key 
of “2”, and field C has a sort key value of “10”, Visio will place them in the Shape Data 
window in the sequence A, C, B, because the first character “1” in field C is less than the 
“2” in field B.

● Add on drop If selected, Visio opens the Shape Data dialog box whenever the user 
drops a shape containing this field onto a page.

● Hidden If selected, Visio hides this field; that is, the field does not appear in either 
the Shape Data window or Shape Data dialog box. Fields like this are often used 
by programmers to hold intermediate calculations or results that the user does not 
need to see.

Tip The shape data exercises that follow all use the regular Define Shape Data dialog box and 
not the developer version.

Although it is not advertised in any obvious way, you can create, edit, or delete shape data 
fields for more than one shape at a time. If you select multiple shapes before opening the 
Define Shape Data window, the changes you make will be applied to all selected shapes. This 
feature can be very powerful or very destructive, so it pays to be cautious.

Changing Shape Data Attributes
In previous sections of this chapter, you edited shape data and learned about the attri-
butes that comprise each shape data field. In order to appreciate just how flexible and 
powerful the data features of Visio really are, it’s helpful to do two more things: change 
the attributes of several existing data fields (this exercise), and create new data fields (the 
following exercise).
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In this exercise, you will explore and change the attributes of the data fields in one of the 
process shapes in the Human Resources Recruiting Process map.

SET UP You need the HR Process Map drawing for this exercise. Either continue with 
the open copy from the previous exercise or open the HR Process Map_start drawing 
located in the Chapter06 practice file folder and save it as HR Process Map. Open the 
Shape Data window.

 1. Click on the Advertise open job shape to view its shape data. Spend a moment 
looking at the names of the data fields for this shape.

 2. Right-click in the Shape Data window, and then click Define Shape Data.

Visio displays the attributes of the first data field, Cost. Notice that the Label field 
displays Cost, which is the label that appears in the Shape Data window. Notice, 
also, that the Type field is set to Currency.

 3. Click the right-facing arrow next to the Format field. 

Visio provides a list of alternate formats in which the currency value can be dis-
played. (The list you see depends on the Region and Language settings for your 
copy of Windows.) It usually makes sense to leave the format set to System Setting, 
especially if your diagram will be opened in countries that use other currencies than 
the one you use.
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 4. Click in the Value field and then type 125. This value will appear as the default val-
ue for the Cost field the next time you open the Shape Data window for this shape. 
You can still change the value via the Shape Data window, but this provides a way 
for you to specify default values.

 5. Type Enter cost for this process step into the Prompt field. These words will 
appear as a tooltip for this field later in this exercise.

 6. In the Properties section of the dialog box, click Process Number. Visio displays 
the attributes of this field in the upper half of the dialog box.

Note that this is a Number-type field.
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 7. Click the arrow next to the Format field to explore the various formatting options 
Visio provides for numeric data.

 8. Click Owner in the Properties section of the dialog box. Note that the Language 
field is now enabled, allowing you to specify the preferred language for this text 
field.

 9. Click the arrow next to the Format field to explore the various formatting options 
Visio provides for text data.

 10. Click Start Date in the Properties section of the dialog box. Note that this field 
has a Date type and that the Language and Calendar attributes are now enabled. 
These two settings allow you to change properties that affect the presentation of 
the date.
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 11. Click the arrow next to the Format field to explore the various formatting options 
Visio provides for date fields.

 12. Click Status in the Properties section of the dialog box. Note that Status is a 
Variable List-type field.

The Format field is used quite differently for Variable and Fixed List fields than 
for the other field types you’ve explored thus far. For list fields, Format holds a 
semicolon-separated list of values that will appear in the drop-down list in the 
Shape Data window.

In the case of the Status field, the Format field holds the following string of 
characters:

;Not Started;In Progress;Completed;Deferred;Waiting on Input

Important The semicolon at the very beginning of the list causes a null (blank) entry 
to appear at the top of the list. If you do not include a null entry, the user will not be 
able to leave the field blank after he or she has clicked something in the list. Both 
options may be appropriate in different situations: in some cases, a blank entry is not 
acceptable, so you want to force the user to select an entry from the list; in other cases, 
a blank entry is fine. 

 13. Type ;Waiting Manager Approval at the end of the character string in the 
Format field.

Important List entries are delimited by semicolons (“;”). Be sure to type the semicolon 
before Waiting Manager Approval so that the new text becomes a separate entry in the 
list.

 14. Type In Progress in the Value field.

Tip If you want a value from the list to appear as the default for this field whenever the 
Shape Data window is opened, type it in the Value field. Be sure that the entry you type 
exactly matches a list item in the Format field, including upper and lower case letters.

 15. Click OK. 

The Shape Data window reflects the changes you made to the fields: there is a de-
fault dollar amount in the Cost field and the Status is preset to In Progress.
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 16. Point to the label for the Cost field. Enter cost for this process step appears as 
tooltip text because you typed it in the Prompt field in Step 5 of this procedure.

 17. Click in the Status field and then click its arrow to display the list. Note that Waiting 
Manager Approval appears at the end of the list.

CLEAN UP Save your changes to the HR Process Map drawing, but leave it open if 
you are continuing with the next exercise.

Creating New Shape Data Fields
Now that you have successfully modified data fields for Visio shapes, you are ready to 
create a new shape data field.

In this exercise, you will add a new field to a shape that already contains other data 
fields.

SET UP You need the HR Process Map drawing for this exercise. Either continue with 
the open copy from the previous exercise or open the HR Process Map_start drawing 
located in the Chapter06 practice file folder and save it as HR Process Map. Open the 
Shape Data window.

 1. Click the Advertise open job shape to view its shape data.

 2. Right-click anywhere in the Shape Data window, and then click Define Shape 
Data.

 3. Click the New button at the bottom of the Define Shape Data dialog box. The 
focus shifts to the Label field, allowing you to type a label for this field.



 Creating New Shape Data Fields  185

 4. Type Estimated duration.

 5. Click the down arrow to the right of Type, and then click Duration.

 6. Click the right arrow next to Format.

 7. Click Days.

Tip You can set the format for a duration field to display the time in any of the standard 
Visio durations, ranging from seconds to weeks, or you can display the duration in one 
of the two listed time formats.
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 8. Click OK to close the Define Shape Data dialog box and return to the Shape Data 
window. Note that the field you created has been added to the bottom of the 
window.

CLEAN UP Save your changes to the HR Process Map drawing, and then close it.

Tip In a similar manner that was described at the end of the section titled “Editing Shape 
Data” earlier in this chapter, you can add, edit, or delete data fields for more than one shape at 
a time. To do so, select multiple shapes before opening the Define Shape Data dialog box.

If you select multiple shapes prior to opening the Shape Data window, you will see only the 
fields that all selected shapes have in common.

Linking Diagrams to External Data
Important The information in this section applies only to the Professional and Premium 
editions of Visio 2010.

Earlier in this chapter, you learned how to add and edit shape data fields. It’s convenient 
to be able to do so manually, but it’s also easy to imagine situations in which you would 
like to populate your drawings with data from a spreadsheet or database or other exter-
nal source.

Prior to Visio 2007, it was possible to link Visio shapes to external data, but it was rather 
cryptic, somewhat confusing, and the procedures often required programming or at 
least some technical knowledge.

Visio 2007 Professional changed that, and both the Professional and Premium editions of 
Visio 2010 include the same data linking facility. In general, there are two steps involved 
in data linking:

 1. Link the drawing to a data source.

 2. Link the data to individual shapes.

In this exercise, you will link the process steps in the Human Resources Process Map 
drawing to data in an Excel spreadsheet.
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SET UP You need the HR Process Map_start drawing and the HR Process Data_start 
workbook located in the Chapter06 practice file folder to complete this exercise. 
Open the drawing in Visio and save it as HR Process Map with data. Then open the 
HR Process Data_start workbook and save it as HR Process Data. 

 1. In the Excel workbook, examine the data it contains. In particular, notice the col-
umn headings.

 2. In Visio, on the Data tab, in the Display Data group, click the Data Graphics 
button, and then clear the Apply after Linking Data to Shapes check box.

Visio will not apply a data graphic to shapes after you link them to data later in this 
exercise.

See Also You will learn about data graphics in Chapter 10, “Visualizing Your Data.”

Tip Although you are turning data graphic activation off for this exercise, in many 
situations, it is valuable to turn it on so you can immediately see the results of your data 
linking operation.

 3. In Visio, on the Data tab, in the External Data group, click the Link Data to 
Shapes button. The first page of the Data Selector wizard appears.

Data Graphics

Link Data 
to Shapes
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Tip The default data type on the first page of the Data Selector wizard is Microsoft 
Excel Workbook, which is the one you will use for this exercise. However, notice that you 
can link to data stored in Microsoft Access, Microsoft SharePoint,, Microsoft SQL Server, 
or almost any other database.

 4. Click Next. 

 5. On the next Data Selector wizard page that appears, click the Browse button, and 
in the resulting file open dialog box, navigate to the HR Process Data Excel work-
book. After selecting the correct file, click the Open button. 

The file name you selected appears in the What Workbook Do You Want To Import 
box.

 6. Click Next.

On this page of the wizard, you will choose which worksheet contains the data to 
which you want to link. The Data Selector wizard usually defaults to the first work-
sheet in the workbook (Sheet1$), which is correct for this exercise.
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 7. Select the First row of data contains column headings check box to indicate 
that the worksheet data includes column headings.

Tip It is very helpful if your Excel workbook contains column headings, and if they 
match exactly to the names of the shape data fields in Visio. If the names match, Visio 
will know exactly how to map the data from the data source to the shapes.

 8. Click Next to accept the defaults for both settings on this page of the wizard.

On the Connect To Data page of the wizard you can customize the columns and 
rows from the selected worksheet that will be linked. As you can see in the follow-
ing graphic, the default is all columns and all rows, which works for this exercise.

 9. Click Next.

On this page, Visio recommends a field that appears to uniquely identify each row 
of data based on its analysis of your data. You can change to a different field if 
there is a better choice.
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Tip You can select more than one field to constitute the unique ID if a single field is not 
sufficient.

The guesses Visio makes for the unique ID are generally pretty good. However, you 
should always think about the recommendation to determine whether there is a 
different field or combination of fields that is a better choice.

If your data does not contain a unique value for each row, you can click the option at the 
bottom of this page of the wizard to signify this, allowing Visio to use the sequence of 
the rows to identify them. Although this choice will work fine for reasonably stable data 
sets, be aware that using this option has potentially serious consequences later on if you 
reorder, add, or delete columns. 

 10. Click Next to display the final page of the wizard.

 11. Click Finish.

Visio now displays the External Data window under the drawing pane. The External 
Data window contains one row for each row of data in your spreadsheet.

Tip In this exercise, you will link to only one Excel worksheet. However, it is possible to 
link a single diagram to more than one data source whether the sources are all of the 
same type or consist of a mix of databases, spreadsheets, and SharePoint lists.
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 12. Drag data row 101 onto the Log hiring request process shape.

As you drag the data row, notice that the cursor appears to be dragging an outline 
of a shape across the page (see the following graphic on the left). Also, notice that 
the cursor is accompanied by a plus sign (+). This is the method Visio uses for letting 
you know that you are dragging the data for a specific shape type across the page.

Tip If you are dragging a data row onto a shape that is already on the page, as you are 
in this exercise, it doesn’t matter whether the shape under the cursor matches the target 
shape. Visio will add the data to the existing shape.

In addition to dragging data rows onto existing shapes, you can create new shapes by 
dragging a data row onto a blank area of the drawing page. To do this, click once on the 
desired master in the stencil to select it, and then drag a data row onto the page. The 
shape under the cursor will reflect the master you’ve selected.

As the cursor moves onto the target shape, the plus sign is replaced by a link-
ing symbol. In addition, the outline shapes take on a thicker, blue border (see the 
graphic on the right).

 

The end result of the drag and drop doesn’t change the appearance of the shape 
on the page but you’ll notice the addition of a linking symbol at the left end of the 
top data row, as shown in the following graphic.

Tip If you need to know which row is linked to which shape, right-click on the row, and 
then click Linked Shapes to see the answer. If you need to remove the link between a 
data row and a shape, right-click on the row, and then click Unlink.

 13. Open the Shape Data window for the Log hiring request shape.
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As you can see, the data from the Excel spreadsheet now resides in the Visio shape. 
And even more important, potentially, is that this is a live link, as you’ll see in the 
next section.

 14. Drag the remainder of the data rows onto the shapes on the page. Shape 102–104 
are left-to-right in the top row, and shapes 105–108 are left to right across the bot-
tom row. (The End shape does not have a data row.)

The final result is a fully linked set of data rows.

 

Tip The name on the tab at the bottom of the External Data window is the name of the 
worksheet in the linked Excel workbook. If you will be linking a diagram to more than 
one worksheet or even to worksheets in more than one workbook, it is useful to give 
each worksheet a unique name.

CLEAN UP Save your changes to the HR Process Map with data drawing in Visio and 
save your changes to the HR Process Data workbook in Excel. Leave both files open if 
you are continuing to the next exercise.

Tip When you populate shapes with data from the External Data window, Visio matches the 
external data column names with the names of the shape data fields in the target shape. If 
there are no matching shape data fields, Visio creates new shape data fields to accommodate 
the external data.
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Refreshing All Data in Linked Diagrams
Important The information in this section applies only to the Professional and Premium 
editions of Visio 2010.

After you have linked data to a Visio drawing, there is a live connection between the two 
files. In fact, you can make changes to the data source and have those changes appear 
either manually or automatically in the Visio drawing. This is true whether the drawing is 
linked to a single data source or to multiple sources.

In this exercise, you will update cells in the Excel data source and see those changes in 
the Visio shapes.

SET UP If they are not already opened, open the HR Process Map with data Visio 
drawing and the HR Process Data Excel workbook that you created in the previous 
exercise.

 1. In the Excel spreadsheet, type Hiring Manager in the Owner cell for process num-
ber 104 that currently contains Recruiter.

 2. Type 4/15/2011 in the Start Date cell for process step 104 that currently contains 
4/18/2011.

 3. Type In Progress in the Status cell for process step 105 that currently contains 
Not Started. 

The following graphic highlights the three changes you’ve just made.

 

 4. Switch to Visio. Then on the Data tab, in the External Data group, click the 
Refresh All button (do not click the arrow).

Tip As an alternative, you can also right-click in the External Data window and click 
Refresh Data.

Refresh All
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Visio reads data from all linked data sources and shows the result in the Refresh 
Data dialog box.

 

Tip It is not necessary to close the spreadsheet or other data source in order to update 
the Visio drawing. 

Occasionally, Visio may display the following dialog box. If you know that the data links 
in your drawing are correct and safe, click OK. You can prevent future display of this 
dialog box by selecting the Don’t Show This Message Again check box.

 5. In the Refresh Data dialog box, click Close.

Compare the data in the External Data window with the spreadsheet in Step 3 and 
you can see that the changes have been applied to the data in the drawing. For final 
proof, you should examine one of the shapes whose data you’ve changed.

 6. Open the Shape Data window for the shape titled Interview candidates. The 
shape correctly reflects the new data in the Excel workbook.
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CLEAN UP Save changes to the HR Process Map with data drawing and the HR 
Process Data workbook but leave them open if you are continuing with the next 
exercise.

Important The data linking mechanism of Visio is designed for one-way data transfer, that is, 
for importing data into a Visio diagram. The opposite does not work. In other words, you can 
refresh the data in a drawing after making changes in a linked data source, but you cannot 
make changes to data in Visio and then push those changes to the linked data source.

Refreshing Selected Data in Linked Diagrams
Important The information in this section applies only to the Professional and Premium 
editions of Visio 2010.

The procedure in the previous exercise automatically refreshes data from all linked data 
sources. Many times, this is exactly what you want to do. However, if your Visio diagram 
is linked to several data sources, there may be times when you want to update the draw-
ing from a subset of the linked repositories.

In this exercise, you will refresh data from some but not all active data sources.

SET UP If they are not already opened, open the HR Process Map with data Visio 
drawing and the HR Process Data Excel workbook that you worked with in the 
previous exercise.

 1. In Visio, on the Data tab, in the External Data group, click the Refresh All arrow 
(below the button), and then click Refresh Data to open the Refresh Data dia-
log box.Refresh All
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 2. Select one or more data sources. 

Tip There is only one data source in this exercise, but if you’ve linked a drawing to more 
than one, they will all be listed in this dialog box.

 3. Click the Refresh button, and then click Close.

CLEAN UP Save changes to the HR Process Map with data Visio drawing and the HR 
Process Data Excel workbook but leave them open if you are continuing with the 
next exercise.

Scheduling Data Refresh
Important The information in this section applies only to the Professional and Premium 
editions of Visio 2010.

The preceding two exercises showed you how to manually update the data in your dia-
gram by rereading the data sources. It’s easy to imagine situations in which you would 
like to have Visio update the data without manual intervention. Each scenario in the fol-
lowing list would be a good candidate for this feature:

● A network or rack diagram that is used to display near real–time network and server 
status

● A call center seating chart that shows which agents are on the phone and which are 
available

● A process map that shows up-to-date task status

● A factory floor plan that displays production statistics, performance threshold 
warnings, and safety issues

In this exercise, you will set a schedule so Visio will refresh your drawing automatically.
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SET UP If they are not already opened, open the HR Process Map with data Visio 
drawing and the HR Process Data Excel workbook that you worked with in the 
previous exercise.

 1. In Visio, right-click anywhere in the External Data window, and then click 
Configure Refresh to open the Configure Refresh dialog box.

Tip As an alternative to Step 1, you can open the Refresh Data dialog box shown in the 
previous two sections, select one or more data sources, and then click the Configure 
button.

 2. In the Configure Refresh dialog box, select the Refresh every nnn minutes 
check box.

 3. Type 10 or use the spinner control to set the desired refresh interval, and then click 
OK.

From this point forward, whenever your drawing is open, the data will refresh auto-
matically at the specified time interval. The data will not refresh when the drawing 
is closed.

CLEAN UP Save and close the HR Process Map with data Visio drawing and the HR 
Process Data Excel workbook. 

Linking Data to Shapes Automatically
Important The information in this section applies only to the Professional and Premium 
editions of Visio 2010.

After completing Steps 12-14 in the section titled “Linking Diagrams to External Data” 
earlier in this chapter, you were probably thinking “There must be a better way to link 
data to shapes!” Fortunately, there is. Visio includes an automatic linking facility that 
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works very nicely when both the data and the shapes contain matching unique identi-
fiers. The key to the automatic linking facility is in the previous sentence: the shapes 
on the drawing page and the data in your spreadsheet or other data source must have 
matching IDs. 

In this exercise, you will first prepare your drawing by adding IDs to the shapes, and then 
you will automatically link the data to the shapes.

SET UP You need the HR Process Map_start drawing located in the Chapter06 
practice file folder for this exercise. Open the file in Visio. 

 1. Click the Log hiring request process shape.

 2. In the Process Number field, type 101.

 3. Click the Prepare job description and screening questions process shape.

 4. In the Process Number field, type 102.

 5. Continue assigning sequential numbers to the process and decision shapes in the 
flowchart, numbering from left to right in the top row and then the bottom row.

 6. Save the drawing as HR Process Map with IDs.

Now that you’ve prepared the drawing, it is easy to link data to shapes 
automatically.

 7. Follow Steps 2–11 in the section “Linking Diagrams to External Data” earlier in this 
chapter. This will connect your drawing to the spreadsheet and open the External 
Data window.

 8. On the Data tab, in the External Data group, click the Automatically Link button.

If you did not select specific shapes before performing this step, you will see the 
following page of the wizard exactly as shown. If you did select one or more shapes 
before performing this step, the Selected Shapes option will be available so that 
you can automatically link just those shapes.

Automatically 
Link
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 9. Click Next.

On this page of the wizard, you tell Visio how to match data with shapes by in-
dicating the column name in the data and the field name in the shapes that are 
equivalent.

 10. Under the Data Column heading, click Process Number in the list.

 11. Under the Shape Field heading, click Process Number in the list.

Tip If you need to specify multiple conditions for matching data to shapes, click the 
And button and enter additional conditions.
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 12. Click Next. The final wizard page summarizes your choices.

 13. Click Finish.

The data has now been linked to all matching shapes as you can see from the link 
symbols in the External Data window.

 

CLEAN UP Save your changes to the HR Process Map with IDs drawing, and then 
close it.

Running a Predefined Report
Now that you know how to use and modify existing data fields and how to create new 
fields, the next logical step is to explore ways to use all of that data. 

Visio 2010 provides a reporting facility that lets you extract data in a variety of ways 
in order to summarize and present it. Many of the built-in Visio templates include pre-
defined reports. You can also design your own reports by stepping through the provided 
report definition wizard.
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In this exercise, you will run one of the built-in reports.

SET UP You need the HR Process Map with data_start drawing located in the 
Chapter06 practice file folder to complete this exercise. Open the drawing in Visio 
and save it as HR Process Map Reports.

 1. On the Review tab, in the Reports group, click the Shape Reports button. The 
Reports dialog box opens.

 2. In the Reports dialog box, click once on Flowchart in the list of reports.

At the top of the Reports dialog box, there are two predefined reports: Flowchart 
and Inventory. The Flowchart report is part of the flowchart template in Visio and 
will appear whenever you create a diagram using that template. The Inventory 
report is a generic Visio report that counts shapes and is present every time you 
open the Reports dialog box.

Because you selected the Flowchart report, notice that there is a description of the 
report in the center of the dialog box.

 3. Click Run. The Run Report dialog box opens.

Shape Reports
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The Run Report dialog box offers four different report output options:

❍ Excel Drops the formatted report data into Microsoft Excel. The report data 
can be edited.

❍ HTML Drops the report into Windows Internet Explorer. This report format is 
read only.

❍ Visio shape Creates a new Visio shape that contains the report data. (For the 
technically inclined: this shape is actually an embedded Excel object, so after 
creating it, you can double-click the report shape and edit the data as though 
you were using Excel.)

❍ XML Creates an XML file containing the formatted report. The report data 
can be imported into an XML-aware application or can be edited.

 4. Click Excel, and then click OK to open the Flowchart report.

Tip This report includes subtotals for each entry in the Master Name column.

 

 5. On the Review tab, in the Reports group, click the Shape Reports button. 
Then click Flowchart and the Run button in the Reports dialog box to run the 
Flowchart report again.

 6. In the Run Report dialog box, click HTML, and then click OK. Internet Explorer 
opens and displays the report.
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 7. On the Review tab, in the Reports group, click the Shape Reports button. 
Then click Flowchart and the Run button in the Reports dialog box to run the 
Flowchart report again.

 8. In the Run Report dialog box, click Visio shape, and then click OK. As you can 
see in the following graphic, the new shape object can be quite large, depending 
on the amount of data in your drawing, so you’ll probably want to cut and paste it 
onto a separate page.
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 9. On the Review tab, in the Reports group, click Shape Reports.

 10. In the Reports dialog box, click Inventory. Notice the description of this report—
essentially, it just counts all occurrences of every shape on the page.

Tip The Show Only Drawing-Specific Reports option at the bottom of the dialog box 
is selected by default. Generally, this is a good thing because it prevents Visio from 
showing you a list of extraneous reports. However, if you’re looking for a report that 
doesn’t appear on the list when this option is selected, you can clear it. Doing so for the 
previous dialog box produces a long list of reports.
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 11. Click Run.

 12. Double-click Visio shape in the Run Report dialog box to execute the report and 
create a new Visio shape.

In the portion of the drawing page shown in the following graphic, the inventory 
report displays a simple count of each shape type.

CLEAN UP Save your changes to the HR Process Map Reports drawing but leave it 
open if you are continuing with the next exercise.

Creating a New Report
Visio provides a Report Definition wizard so you can create new reports or modify exist-
ing reports. In this exercise, you will create a new report for the Recruiting Process.

SET UP You need the HR Process Map Reports drawing for this exercise. Either 
continue with the open copy from the previous exercise or open the HR Process Map 
with data_start drawing located in the Chapter06 practice file folder and save it as HR 
Process Map Reports.

 1. On the Review tab, in the Reports group, click the Shape Reports button. The 
Reports dialog box opens.

 2. In the Reports dialog box, click the New button. The Report Definition Wizard 
opens.

The Report Definition Wizard lets you select a set of shapes to include in the 
report.

Shape Reports
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 3. Click Shapes on the current page if it’s not already selected, and then click Next.

This page of the Report Definition Wizard shows the fields that you are most likely 
to want in your report. If you don’t see the field you’re looking for, select the Show 
All Properties check box.

 4. Select the <Displayed Text> check box, scroll down and select the check boxes for 
Owner, Process Number, Start Date and Status, and then click Next. The next 
wizard page opens.
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 5. Type HR Report in the Report Title text box.

 6. Click the Sort button so you can specify the order in which you want the data to 
appear in the report.

 7. In the Sort dialog box, in the Row Order section, click the arrow next to Sort by, 
and then select Process Number.

Tip You can sort by as many as three fields in the Row Order section.

 8. In the Column Order section, click once on Process Number, and then click the 
Move Up button twice to set the column sequence as shown in the following 
graphic.
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 9. Click OK to close the Sort dialog box.

Tip The text under the Sort button identifies the sort field(s) you selected.

Be sure to note the Subtotals and Format buttons that allow you to customize the report 
output in additional ways beyond what you will use for this sample report.

 10. Click Next to open the final page of the Report Definition Wizard.

 11. Type Custom HR Report in the Name text box.

 12. Type HR Process report showing task number, task description, owner, start 
data and status in the Description text box.
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You can save the report definition in the current Visio drawing, which is the default, 
or you can save it to an external file.

Tip Save the report definition to an external file if you think you’ll want to use it with 
multiple drawings. If you do, you can retrieve the report definition by clicking the 
Browse button in the Reports dialog box shown in the following graphic.

 13. Click Finish. Your report appears in the list of available reports in the Reports dia-
log box and you can run it in the usual way.

 14. Click Run in the Reports dialog box.

 15. Double-click Visio shape in the Run Report dialog box. Your custom report 
appears on the drawing page.
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When you save the changes to this file, your report definition will be saved with 
your drawing.

CLEAN UP Save your changes to the HR Process Map Reports drawing but leave it 
open if you are continuing with the next exercise.

The report you’ve just created is interesting, but needs some fine tuning. For example, 
there are blank rows because some shapes on the page, the arrows, do not contain any 
data. To modify the report, continue reading in the next section.

Modifying an Existing Report
Whether you are using a predefined Visio report or one you’ve created, there are times 
when you want it to produce different output. 

In this exercise, you will modify the HR Report you created in the previous section to 
eliminate the blank rows.

SET UP Open the HR Process Map Reports drawing that you saved in the previous 
exercise, if it is not still open. If the HR Report is still on the drawing page, click it 
once to select it, and then press Delete.

 1. On the Review tab, in the Reports group, click the Shape Reports button.

 2. In the Reports dialog box, click Custom HR Report in the list of reports.

 3. Click the Modify button. The Report Definition Wizard appears.
Shape Reports
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 4. On the first page of the Report Definition Wizard, click the Advanced button. 
The Advanced dialog box opens.

In the Advanced dialog box, you can limit the number of rows in the report by 
setting selection criteria.

 5. Under the Property heading, click the arrow, and then click Process Number.

 6. Under the Condition heading, click the arrow, and then click is greater than. 

 7. Under the Value heading, type 0. 

 8. Click the Add button to add your selections to the Defined criteria list.

 9. Click OK.

 10. Click Next three times in the wizard, and then click Finish to save the 
updated report definition.

 11. In the Reports dialog box, click Run.
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 12. Double-click Visio shape. 

The modified version of the report appears without any blank rows. Compare this 
report to the one at the end of the preceding exercise.

CLEAN UP Save and close the HR Process Map Reports drawing.

Tip It would be a good idea to experiment with the other buttons and option settings in the 
Report Definition Wizard while everything is fresh in your mind. There are many other ways 
that you can customize Visio reports.

Key Points
● Shape data exists in, or can be added to, any shape on a Visio drawing page. A 

growing percentage of Visio drawings are valuable not just because they are attrac-
tive pictures, but because they are visual representations of real-world data.

● Visio diagrams do not need to exist in isolation. You can link your drawings to per-
sonal or organizational data repositories of almost any type, ranging from simple 
spreadsheets to SharePoint lists and almost any kind of database.

● The data in a linked Visio drawing can be updated manually or you can schedule 
updates to occur at a preset time interval.

● Many Visio templates include predefined reports that you can run to export summa-
rized data to webpages, Excel files, and other formats. In addition, the Visio Report 
wizard steps you through editing existing reports or creating your own.
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establishing default position 308
example 64
network diagrams 300–301
process improvement workflows 302
rack diagrams 300–301
risk management 303
turning off on shapes 305
using existing 304–306

Data Graphics gallery
Apply After Linking Data To Shapes check box 305
editing data graphics 307–312
opening 304, 313
turning off data graphics on shapes 305
using existing data graphics 304–306

data graphics legends
about 347
creating 317–319
example 302
modifying 319

data linking
via data linking facility 186–192
refreshing all data 193–195
refreshing selected data 195
to shapes automatically 197–200

data linking facility 186–192
Data Selector Wizard 187–190
Data tab

about 4, 11
components 11
versions supporting 4, 11

data validation 175–177
date field

defined 172
entering values 176

Decision shape
adding/deleting 60
connecting 55, 56, 58
creating flowcharts 115

contextual tab sets
Container Tools 15, 329, 331
defined 15
Picture Tools 15, 94

control handles
defined 29
hiding unused 274

controls
page 18
in status bar 19
toggling displays of 20
tooltips for 12

Controls stencil 346
copying and pasting

containers 331
shapes 42–43

Created in date span shape 371
Create from Selection button 367
Create New button 369
Cross-Functional Flowchart add-in

list and container usage 338–342
Orientation button 121
predefined business rules 356
Swimlane button 121

cross-functional flowcharts
about 111, 119
creating 120–125
list and container usage 338–342

Ctrl+A keys 42
Ctrl key

following hyperlinks 65, 217
selecting noncontiguous items 134
selecting shapes and 41
zooming views 26

Ctrl+K keys 216, 286
Ctrl+Shift keys 25
Ctrl+Shift+W keys 26
Ctrl+V keys 43
Ctrl+Z keys 128
currency field 172
Current View button 244
Customize Status Bar menu 20
custom properties. See shape data fields
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Dialogs stencil
Dialog button shape 343
Dialog form shape 343
Panel shape 344
Upper tab item shape 345

Directory server shape 277
Disband Container button 330, 337
Display Data group (Data tab)

Data Graphics button 187, 304, 313, 387
depicted 11
Insert Legend button 318

Display Options button 130
Distribute Shapes dialog box 149
docking windows 173
documents. See drawings/diagrams
Document shape 116
drawing canvas 99
drawing pages

about 17
adding comments 81–84
creating images of 250
moving in drawing window 28
printer page and 244
resizing 20
setting page attributes 98
status bar and 19
tiles on 99

drawing scale
changing 289–292
of rack shapes 282

drawings/diagrams
adding background pages 255–257
adding hyperlinks to 216
applying color 150–154
applying fill patterns 150–154
applying themes to 161–162, 163–166
copying themes between 169
creating 5
creating from sample diagrams 62–66
creating with basic shapes 38–41
data linking facility 186–192
larger than one page 242–244
naming conventions 6
organizing layers in 94–97
packaging in various formats 7
previewing 240–244
printing 240–244
publishing 261–267
publishing to Visio Services 390–397
refreshing linked data 193–195
removing personal information 245–247
saved as websites 380–386
sharing with Visio Viewer 260–261

Define Shape Data dialog box
Add on drop field 179
creating new fields 184–186
Format field 178, 180, 182
Hidden field 179
Label field 178
Name field 179
opening 177, 178
Prompt field 179, 181
Properties section 181, 182
Sort key field 179
Type field 178
Value field 179, 181, 183

Department stencil
Cafeteria shape 91
Headquarters shape 88
International division shape 92

Design tab
about 11
components 11

Detailed Network Diagram stencil 275–278
Detailed Network Diagram template

Basic Network Diagram template and 276
building network diagrams 275–278
predefined reports 292

developer mode
accessing ShapeSheet 409
Define Shape Data dialog box 178, 179
Rules Tools and 376
running in 400–401
selection characteristics of groups 325
shape names and 225

Developer tab
adding to ribbon 225, 401
Code group 407
Shape Design group 402

Diagram Parts group (Insert tab)
Callout button 349
Container button 322, 329
depicted 10

diagrams. See drawings/diagrams
diagram validation

BPMN and 361–362
BPMN diagrams 362–366
validating flowcharts 357–361

Diagram Validation group (Process tab)
Check Diagram button 357, 360, 366
depicted 11
Window check box 361

dialog box launcher
defined 10
legacy text formatting dialog boxes 73

Dialog button shape 343
Dialog form shape 342, 343



424  drawing window

Edit Item button 310
Edit Item dialog box

about 309
Details section 311
displaying item parameters 309
Display section 309, 310
opening 309
Position section 310, 311
Use Default Position check box 309

effects
custom themes and 167
fill patterns for 154

Effects gallery 167
Ellipse tool 40, 41
email addresses, hyperlinks to 219
EMF file format 248
End event (BPMN) 361
End Event shape (BPMN) 368
Enterprise Client Access License (ECAL) 391
error dialog box 175
Esc key 71, 242
Ethernet shape 272, 276
Event shape type (BPMN) 361
Event Type entry (BPMN) 364
Executive shape 126
Expand the Shapes window arrow 21
Export button 372
exporting SharePoint Workflow diagrams 11, 

370–373
Export Workflow dialog box 372
Extensible Application Markup Language 

(XAML) 380, 384
External Data group (Data tab)

Automatically Link button 198
depicted 11
Link Data to Shapes button 187
Refresh All arrow 195
Refresh All button 193

external data, linking automatically to 
shapes 197–200

external data, linking diagrams to 186–192
External Data window

accessing 11
closing 63
Configure Refresh dialog box 197
displaying 190
naming conventions 192
Refresh Data option 193

External Data Window button 63

drawing window
depicted 18
exploring 17–20
moving drawing page in 28
zoom techniques in 25–28

Drawn by shape 255
duration field

defined 172
setting format 185

DWG file format 253
DXF file format 253
dynamic connectors

adjusting 51
AutoConnect support 56
connecting shapes with 47–51
defined 47
deleting 59, 61
layers and 97
in network diagrams 274
1-D shape behavior and 52

dynamic glue
connecting shapes with 51
defined 49
1-D shape behavior and 52

Dynamic Grid button 38, 41
Dynamic Grid feature

activating 38
feature limitations 52
turning off 41
using basic shapes 38–41

E
ECAL (Enterprise Client Access License) 391
Edit Data Graphic dialog box

about 307
Default position section 308
displaying item parameters 309
Edit Item button 310
Show Border Around Items At Default Location 

check box 308
editing

data graphics 307–312
hyperlinks 233–234
shape data 175–177

Editing group (Home tab)
depicted 10
Find button 294
Layers button 95, 96
Replace button 295
Select button 42
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flowcharts
adding labels to 118–119
auto-arrange features 148–149
common usage 111
creating 114–117
cross-functional 111, 119, 120, 338–342
orientation considerations 114
process maps and 355
selecting types 112–114
validating 357–361

flowchart shapes 97
flowchart templates

Flowchart report 201
selecting stencils 22
support for 23, 112

fluent user interface 399
folders

navigating to 257
selecting on SharePoint sites 393
Visio-generated files 386

Font Color button 156
Font group (Home tab)

depicted 10
Font Size arrow 72
Font Size list 70
legacy text formatting dialog boxes 73
setting font size 161

Font Size arrow 72
Font Size list 70
footers 242
foreground pages

associating with background pages 98
defined 98

Format contextual tab
activating 329
for Container Tools 15, 329
for Picture Tools 15
image properties and 94

Format Painter button 158
Format Painter feature 157
formats/formatting

applying line styles and colors 154–157
containers 331
Format Painter feature 157
legacy dialog boxes 73
lists 337
supported 7
text boxes 71–73

45 degree double arrow 100
Freeform tool

about 40
connecting shapes with 46, 47
1-D shape behavior and 51

Free-standing Rack Equipment stencil 285
Full Screen button 20
functional bands. See swimlane diagrams

F
F2 key 70
F4 key 147
fades, fill patterns for 154
Fax shape

accessing 85
Product Number field 87

Field button 86
Field dialog box

Category section 87, 405
Custom Formula category 405
Date/Time category 405
Field name section 87
opening 87

file formats
additional formats 7, 252–255
graphics files 247–252

File Locations button 258
File Locations dialog box 258
file management 7, 399
File server shape 276
File tab. See Backstage view
Fill button 151, 331
Fill Color list 314
Fill dialog box

about 152
Color arrow 152
Fill section 152
opening 151
Pattern list 153, 154
Preview section 152
reversing fill patterns 153

fill patterns
applying to drawings 150–154
difficulty displaying 152
reversing 153
theme effects and 161

Fill tool 278
Find button 294
Find dialog box 294
Firefox browser 263
Fit Page To Current Window button 20
fixed lists

defined 172
Format field and 183
selecting entries 177

flowchart reports 201, 383
flowchart rule set 374



426  Gateway shape (BPMN)

Header and Footer dialog box 241
headers 242
Heading Style button 331
Heading Style gallery 337
Headquarters shape 88
Height button 19, 88
Help page 8
hiding

additonal handles 273
org chart sections 138
Shapes window 22
unused control handles 274
windows 173

Home tab 10
horizontal spacing 149
HTM file format 254, 386
HTML

bookmark support 219
report output options 202

hyperlink base 231–233
Hyperlink base text box 232
hyperlinks

about 217
absolute 226–231
adding 216
adding multiple 234
applying to selected shapes 287
to documents 219–221
editing 233–234
to email addresses 219
example 65
to pages 224–226
relative 226–231
to specific locations within documents 221–223
to websites 218

Hyperlinks dialog box
adding multiple hyperlinks 234
Browse button 234
Description text box 233, 287
Edit Hyperlinks option 233
hyperlinking to pages 224–226
linking to documents 219–221
linking to specific location in documents 222
linking to websites 218
opening 216, 286
Relative Path For Hyperlink check box 226
Use Relative Path For Hyperlink check box 227, 

229, 230

G
Gateway shape (BPMN) 364
Gateways shape type (BPMN) 361
getting started

Backstage view 2
Visio Premium 2010 4
Visio Professional 2010 4
Visio Standard 2010 2

GIF file format 247, 385
glued lines

connection points and 44–46
dynamic connectors and 47–50
dynamic glue and 49, 50, 51
identifying types of glue 51–52
static glue and 50, 51

Goldsmith, John 141, 404
graphics files 247–252
GRAVITY() function 77
grid, background 158–160
Group button 89, 91, 278
group shapes. See also specific groups

bounding box and 89, 326, 328
containers and 322–328
creating and working with 88–92
default behavior for 325
layers and 97
in network diagrams 278–279
resizing 323, 328
selecting 323, 324
selecting interior shapes 328
typing text in 328

groups in ribbon tabs
dialog box launcher and 10
organization of 9, 10
resizing ribbon and 14

guides, positioning shapes with 52–55

H
handles

control 29, 31, 274
dynamic glue and 52
hiding additional 273
resize 90, 284, 323
rotation 30, 74
selection 78
static glue and 52
unglued 52
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J
JavaScript 386
JPEG file format 247, 249, 385
JPG Output Options dialog box 249

K
keyboard shortcuts

about 13
closing print preview 242
following hyperlinks 217
opening Hyperlinks dialog box 216, 286
opening print preview 243
opening Save As dialog box 248
repeating previous operation 147
returning to full page view 26
selecting shapes 42
text edit mode 70
zoom technique 25–26

Keyboard tray shape 285

L
labels

adding to flowcharts 118–119
adding to shapes 70

Language group (Review tab) 11
Laptop shape

adding comments 82
building basic network diagrams 273

lasso select 42
Layer dialog box 95
Layer Properties dialog box

about 96
Active check box 96
Apply button 97
Color check box 97
Glue check box 97
Layer Color setting 97
Lock check box 97
Print check box 96
Snap check box 97
Transparency setting 97
Visible check box 96

layers
about 94
dynamic connectors on 97
groups and 97
pages and 97
pre-assigned to stencils 97
properties supported 96
shapes and 95, 96, 97

I
IDEF0 flowchart template 112
IF() function 403
Illustrations group (Insert tab)

Clip Art button 93
depicted 10
Picture button 92, 105

images
creating graphics 247–252
enhancing org charts with 141
inserting 92–94

importing
pictures 92–94
rule sets 375
SharePoint Workflow 11

Info page
about 6
Properties button 245
Reduce File Size button 245
Remove Personal Information button 245, 246

inserting
pictures 92–94
shape data fields 86–88, 405–406

Insert Legend button 318
Insert Page button 19, 98
Insert Section dialog box 409
Insert tab

about 10
components 10
keyboard shortcut for 13

Intermediate events (BPMN) 361
International division shape 92
International Standards Organization (ISO) 2
Internet Explorer

publishing diagrams and 263
Visio Viewer support 260

Inventory report 201, 204
ISO (International Standards Organization) 2
Issues window

closing 361
Connector is not glued at both ends 358
Decision shape should have more than one 

outgoing connector 358
Flowchart does not end with a Start/End 

shape 358
Flowchart shape has no outgoing connectors and 

is not a Start/End shape 358
Flowchart shape has no text label 360
Ignore Rule 359
Ignore This Issue 359
opening 357
re-sorting list of issues 358
viewing issues 369



428  Layers button

M
macros

default security setting 407
defined 406
recording 19, 406–407
running 406–407

Macros button 19, 406
Macros dialog box 407
Macros group (View tab) 12
Manager shape 126
Markup group (Review tab)

depicted 11
Show Markup option 84

masters
defined 16
shape data fields 84

maximizing ribbon 15
Maximum Number Of Undos setting 62
measurement units

about 2
rack diagrams and 281
stencils and 74
templates and 2

Membership group (Format tab)
Disband Container button 330, 337
Heading Style gallery 337
Lock Container button 331, 337
Select Contents button 329, 337

message flows 362
metric units

Block Diagram stencil and 74
defined 2
rack diagrams and 281

Microsoft Active Directory Topology 
Diagrammer 297

Microsoft Excel workbooks
hyperlinks to 222, 223
report output options 202
storing 393
VBA code and 408

Microsoft PowerPoint 222, 223, 408
Microsoft Silverlight 380, 390
Microsoft Word documents

hyperlinks to 219–221, 221, 223
hyperlinks to locations within 221–223

Minimize the Ribbon button 159
Minimize the Shapes window button 21, 160
minimizing

ribbon 14
Shapes window 21

Layers button 95, 96
Layout group (Design tab) 11
LCD Monitor shape 80, 285
LDAP Directory template 297
Left Arrow key 318
Line button 155, 156, 331
Line dialog box

Arrows section 156
opening 155
Preview section 156
Round corners section 155

lines
applying color to 154–157
connecting shapes with 43–47
determining connectedness 44–45
fill patterns for 154

line styles
applying 154–157
theme effects and 161

Line tool
about 40
connecting shapes with 43–44, 47
1-D shape behavior and 51

Link Data to Shapes button 187
linking data. See data linking
linking symbol 191
Links group (Insert tab) 10
Link to Existing button 369
List Box control 342
List box shape 346
lists

additional information 337
borders around 334
containers and 321, 322, 333, 336
creating 409–410
defined 321
delimiting entries 183
finding 338–348
fixed 172, 177, 183
formatting 337
shapes and 322, 333–337
sizing 337
swimlane diagrams and 125
variable 172, 177, 183

list styles 337
Live Preview

about 57
for callouts 349
in color picker dialog box 151
from Container Styles group 331
displaying container styles 322
Mini Toolbar support 57, 72

Lock Container button 331, 337
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Next Tile button 244
No Theme button 166
number field 172

O
Object button 94
Object Management Group/Business Process 

Management Initiative 362
Octagon shape

aligning 39
positioning 54

Office Layout template 406
one-dimensional shapes

connecting with lines 43
identifying 51

Open Document dialog box 396
Open in Visio button 396
Open Sample Data button 62
options. See Visio Options dialog box
Options dialog box 130
organization charts

about 125
building by hand 126–130
building with existing data 130–138
building with new data 138–140
creating 111
enhancing with pictures 141
hiding sections of 138
manipulating shapes 129
Windows disk drive as 141

Organization Chart Shapes stencil
Assistant shape 128
Consultant shape 128
Executive shape 126
Manager shape 126
Position shape 127
Vacancy shape 128

Organization Chart template 126, 131
Organization Chart Wizard

controlling field positioning 134
data source type page 132
file selection page 132
Hyperlink Employee Shapes Across Pages check 

box 135
layout options 134, 137
Locate The File That Contains Your Organization 

Information box 132
New File Name box 139
Organization Chart template and 126, 131
Synchronize Employee Shapes Across Pages check 

box 135
using with existing data 130–138
using with new data 138–140

Mini Toolbar
applying line styles and color 154–157
Arrows button 156
Bold button 72
Fill button 151
Font Color button 156
Line button 156
Live Preview support 72
Quick Shapes 57
setting font size 75

Monitor shape 285
mouse wheel 26
Move Down button 103
Move Up button 103

N
naming conventions

for drawings 6
External Data window 192

navigation
among comments 84
to folders 257
publishing diagrams and 263, 265
Visio Services and 389

Network and Peripherals stencil
about 85
Ethernet shape 272, 276
Fax shape 85, 87
Printer shape 85, 86, 273
Server shape 85, 87, 273

network diagrams
basic 272–275
data graphics and 300–301
detailed 275–278
organizing shapes in 278–279

New Comment button 82
New Data Graphic dialog box 313
New Item dialog box

Color Assignments section 314
Display section 314
opening 313
Position section 316

New Layer dialog box 95
New page

key functions 3
opening 2, 6, 7
Other Ways To Get Started section 3
Recently Used Templates section 3
returning to 5
starting new drawing 6–9
Template Categories section 3, 5, 120

New Tab button 400
Next button 84



430  Org Chart add-in

Page Setup group (Design tab)
Auto Size button 99
depicted 11
Orientation button 99
Size button 100

Pages group (Insert tab)
Blank Page arrow 105, 255
Blank Page button 98, 100
depicted 10

page titles, formatting text boxes as 71–73
page-to-rack ratio 282
Page Width button 73
Pan and Zoom section (nagivation pane) 265–266
Panel shape 344
Pan & Zoom button 20, 27
Pan & Zoom window 20, 27–28
Paragraph group (Home tab)

Align Left button 79
Align Top button 79
depicted 10
displaying shape text alignment 79
legacy text formatting dialog boxes 73

Parker, David 375, 376, 404
Paste Special dialog box 43
pasting shapes 43
PC shape

adding ScreenTips 81
building basic network diagrams 273
building detailed network diagrams 277
containers example 324

PDF file format 7, 253, 254
Pencil tool

about 40
connecting shapes with 47
1-D shape behavior and 51

personal information, removing 245–247
Picture button 92, 105
pictures

enhancing org charts with 141
inserting 92–94

Picture Tools contextual tab set
about 15
inserting images and 94

pin (Center Of Rotation handle) 30, 33
plus sign (+) 191, 367
PNG file format 247, 251, 385
PNG Output Options dialog box 251
Pointer Tool

applying changes with 73
connecting shapes with dynamic connectors 50
connecting shapes with lines 45
description 116
organizing shapes 278
orienting shape text 78
positioning shape text 79

Org Chart add-in
animation and 126
depicted 16
Display Options button 130
Layout group 128
Move buttons 138
Organization Data group 130
Picture group 141
Re-Layout button 128
Show/Hide Subordinates button 138

orientation
changing defaults 121
flowchart considerations 114
pages 99–101, 103
shapes on pages 73–76
text in shapes 76–78

Orientation button 99
Other Ways To Get Started section

about 3
Sample Diagrams option 62, 302

P
page controls 18
Page dialog box 19
page name tabs

about 19
dragging to resequence pages 103

Page Number button 19
pages

active 100, 105
adding 98, 100
background 98, 104–109, 242, 255
changing drawing scale 289–292
creating data graphic legends 317–319
drawing scales of 282
foreground 98
headers and footers 242
hyperlinking to 224–226
layers and 97
managing 98–104
page-to-rack ratio 282
resequencing 103
setting up 98–104

Page Setup dialog box
about 100
creating templates 255
Custom scale option 291
Drawing Scale tab 282, 290
Page Properties tab 105, 106
Page Size tab 102, 103
preview pane 102
Printer paper section 102
Print Setup tab 101, 102
Setup button 102
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process improvement workflows 302
process maps 355
Process shape

adding labels to flowcharts 118
aligning shapes 145
connecting 55, 58
creating flowcharts 114
creating swimlane diagrams 122

Process tab
about 5, 11, 355
components 11
versions supporting 5, 11

Proofing group (Review tab) 11
Properties button 245
Properties list 6
Publish button 380
publishing drawings/diagrams

to Visio Services 390–397
to websites 261–267

Publish Settings dialog box 392, 393
PurchaseDate shape 406
pushpin button 173

Q
Quick Access Toolbar

about 9
customizing 399, 400
keyboard shortcuts and 13
Save button 396
Undo button 128

Quick Print button 240
Quick Shapes

creating flowcharts 114
stencils and 57
usage examples 55–59

Quick Shapes stencil
Start shape 371
Terminate shape 371

R
rack diagrams

adding equipment to 283–288
creating 280–283
data graphics and 300–301
downloadable stencils/shapes 288
page-to-rack ratio 282

Rack Diagram template 280–283

Pointer Tool button 116
Position button 146
positioning

via Auto Align & Space feature 148–149
background grid and 158
data graphics 308
fields via Organization Chart Wizard 134
Shape Data window 173
shapes 52–55
shape text 78–81

Position shape 127
Power supply/UPS shape 284
predefined reports

Basic Network Diagram template 292
Detailed Network Diagram template 292
modifying 210–212
running 200–205

predefined validation rule sets 373
predefined workflows 370
Preview group (Print Preview tab)

Current View button 244
Header & Footer button 241
Next Tile button 241, 244
Previous Tile button 244
Single Tile button 244
Whole Page button 244

previewing diagrams 240–244
Previous button 84
Previous Tile button 244
Printer shape

accessing 85
Asset Number field 86
building basic network diagrams 273
Manufacturer field 86
Network Name field 86
Product Number field 86

Print group (Print Preview tab) 241
printing

background grid and 159
diagrams 240–244
selecting paper size 102

Print page
about 7
displaying 240
Print Preview option 240

Print Preview tab 240–244
print preview window

closing 242
opening 243

Print server shape 277
print tiles 243
processes. See work processes



432  Rack-mounted Equipment stencil

reports
computer and network 292–293
creating 205–210
desiging with report definition wizard 200
flowchart 201, 383
modifying 210–212
output options 202
predefined 200–205, 210–212, 292

Reports dialog box
Flowchart report 201
Inventory report 201, 204
opening 201
Report Definition Wizard 205
Show Only Drawing-Specific Reports option 204

Reports group (Review tab)
depicted 11
Shape Reports button 201, 202–204, 205, 210

repositioning
shapes 29–34
Text Annotation shape 365
zoom feature suggestions 80

resequencing pages 103
resize handles

containers and 323
enlarging groups 90
sophisticated behavior 284

resizing
containers 328
drawing page 20
groups 323, 328
ribbon 13
Shape Data window 173
shapes 29–34
Text Annotation shape 365
text blocks 80
text boxes 72

Review tab 11
ribbon

about 1, 9
customizing 9, 399, 400
groups in ribbon tabs and 9, 10, 14
interactive guides 12
maximizing 15
minimizing 14
resizing 13

risk management 303
rotating

shapes 30, 73–76
shape text 76–78
zoom feature suggestions 80

rotation handles 30, 74

Rack-mounted Equipment stencil
accessing 281
Keyboard tray shape 285
LCD Monitor shape 285
Power supply/UPS shape 284
Rack shape 283, 289
Router 1 shape 285
Server shape 284

Rack Mounted Servers stencil 277
Rack shape 283, 289
recording macros 19, 406–407
Record Macro dialog box 406
Rectangle shape

positioning 38
resizing 53

Rectangle tool
about 40
constraining 40
organizing shapes 278

Reduce File Size button
about 6
accessing 245

Refresh All arrow 195
Refresh All button 193
Refresh button 395
Refresh Data dialog box 195
refreshing linked data

for all data 193–195
for selected data 195
scheduling 196–197

relative hyperlinks 226–231
Re-Layout button 128
Remove Hidden Information dialog box 246
Remove Personal Information button

about 6
accessing 245, 246

Reorder Pages dialog box 103
repeating previous operation 147
Replace All button 296
Replace dialog box 296
replacing text 294–296
Report Definition Wizard

Advanced dialog box 211
creating new reports 205–210
modifying reports 210–212
opening 210
Show All Properties check box 206
Sort dialog box 207
specifying data order 207



Shape Data dialog box  433

Save & Send page
about 7
Browse for a location option 391
Change File Type button 388
file formats and 255
File Types section 391
Locations section 391
Save to SharePoint option 391

scheduling data refresh 196–197
SCOM (System Center Operations Manager) 397
ScreenTips

adding 81–84
defined 81
deleting 81

SDL Diagram flowchart template 112
searching text 294–296, 390
Search Pages pane 266
security settings, macros 407
Select button (Editing group)

Area Select option 42
Lasso Select option 42

Select Contents button 329, 337
selection handles 78
selection rectangle 90
semicolon (;) 183
Send Backward button 144
sequence flows 362
Server shape

accessing 85
Asset Number field 85
building basic network diagrams 273
default text position 87
Network Name field 85
rack diagrams and 284
Serial Number field 85

Servers stencil 276, 277
Setup button 102
Shadow button 331
shape data

about 84–86, 172
changing attributes 179–184
computer and network reports 292
creating new fields 184–186
editing 175–177
inserting fields 86–88, 405–406
types supported 172
validating 175–177
viewing 172–174
viewing attributes 177–179
web-published drawings and 397

Shape Data dialog box
Shape Data window and 174
wireframes and 344

Roth, Chris 404
Router 1 shape 285
rulers

drawing scale and 290
positioning shapes with 52–55, 74
turning off/on 160

rules
creating new 375
diagram validation and 356
reusing existing 373–375

rule sets
defined 356
flowchart 374
importing 375
removing from active list 375

Rules Tools 375, 376
Run Report dialog box 201, 205, 209

S
sample drawings 62–66
Save As dialog box

Automatically View Files In Browser check box 392
Change Title button 381
navigating to folders 257
opening 248
Publish button 380
Save button 388

Save As Web Page dialog box
Advanced tab 383, 384
Automatically Open Web Page In Browser check 

box 382
Details (shape data) check box 382
Display Options section 385
Go to Page section 383
Host In Web Page setting 385
opening 381
Organize Supporting Files In A Folder check 

box 382
Output Formats section 384
Pages To Publish section 381
Page Title text box 382
Provide Alternate Format For Older Browsers check 

box 385
Publishing Options section 381, 382
Report: Flowchart check box 382
Search Pages check box 382
Style Sheet setting 385
Target Monitor setting 385

Save As Web Page function 262, 267, 386
Save button 388, 396



434  Shape Data window

keyboard shortcuts 42
labeling 70
layers and 95, 96, 97
linking data automatically to 197–200
lists and 322, 333–337
manipulating 29–34
organizing in network diagrams 278–279
orienting on pages 73–76
orienting text in 76–78
positioning text in 78–81
positioning with rulers/guides 52–55, 74
Properties submenu 174
removing links with data rows 191
report output options 202
repositioning 29–34
rotating 30, 73–76
selecting 41–42
as sheets 225
spacing 144–148
transferring formatting between 157
turning off data graphics 305
ungrouping 91
using with Dynamic Grid feature 38–41
viewing dimensions in status bar 19
wireframe 342–347

Shape ScreenTip dialog box 82
ShapeSheet

about 402
accessing 409
lists and 333
modifying 401–405, 409
opening 402
Text Transform section 77
User-defined Cells section 410
viewing 401–405

ShapeSheet Tools Design contextual tab 402
Shapes window

about 18
changing width 21
Computers And Monitors stencil 80, 81
Cross-Functional Flowchart Shapes option 22
Department stencil 88
Expand the Shapes window arrow 21
hiding 22
Minimize the Shapes window button 21
minimizing 21
Rack-mounted Equipment stencil 281
returning to former size 21

SharePoint Designer 370–373
SharePoint Server

rendering workflow to 370
saving websites on 387–389
Visio Services 389

Shape Data window
accessing 11
Define Shape Data dialog box 180
hiding 173
opening 395
opening Define Shape Data dialog box 178
positioning 173
relocating 85
resizing 173
scroll bar 86
Shape Data dialog box and 174
viewing shape data 173
viewing shape names 226

Shape Design group (Developer tab) 225
Shape group (Home tab)

depicted 10
Fill button 331
Fill tool 278
Line button 155, 331
Shadow button 331

Shape Name button 225
Shape Name dialog box 225
Shape Reports button 201, 202–204, 210
shapes. See also group shapes

adding hyperlinks to 216
adding multiple hyperlinks to 235
adding ScreenTips 81–84
adding text to 70
adding with AutoAdd 59–62
aligning 38–39, 144–148
altering in org charts 129
anchor 145
annotating with callouts 348–352
applying hyperlinks to 287
assigning to layers 96
associations between 362
background 278–279
boundary 333
changing order of appearance 58
comments and 84
connecting with dynamic connectors 47–51
connecting with lines 43–47
constraining movement 117, 368
containers and 321, 325, 328
copying and pasting 42–43
copying data graphics and 317
Data submenu 172
defined 17
deleting with AutoDelete 59–62
downloadable 288
dragging data rows onto 191
identifying 51
images as 94
inserting fields 86–88
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Start/End shape
adding labels to flowcharts 118
connecting 55, 57
creating flowcharts 114
creating swimlane diagrams 122

Start events (BPMN) 361
Start shape

from BPMN stencil 364
from Quick Shapes stencil 371

static glue
example of 51
1-D shape behavior and 52

status bar
about 19
Customize Status Bar menu 20
displaying shape information 105
Fit Page To Current Window button 20
Full Screen button 20
Language area 19
Macros button 19
opening Size & Position window 19, 32
Page Number button 19
Pan & Zoom button 20, 27
Switch Windows button 20
Width button 272
Zoom Level button 20
Zoom slider 20

stencils. See also specific stencils
BPMN support 362
closing 24
defined 17
downloadable 278, 288
identifying active 22
pre-assigned layers 97
Quick Shapes section 57
shape data fields 84
in Shapes window 18

storing
custom templates 258
Excel workbooks 393

string field 172
subprocesses

creating 366–369
defined 366

Subprocess group (Process tab)
Create from Selection button 367
Create New button 369
depicted 11
Link to Existing button 369

Subprocess shape
adding/deleting 59–62
hyperlinking 263

subwindows 22
SVG file format 248, 384
Swimlane button 121

SharePoint Workflow Actions stencil 371, 372
SharePoint Workflow Conditions stencil 371
SharePoint Workflow diagrams

creating 370–373
exporting 11, 370–373
importing 11

SharePoint Workflow group (Process tab) 372
SharePoint Workflow template

about 356, 370
predefined business rules 356
workflow exercise 371

sheets
defined 225
finding shape names 225

Shift key
constraining shape tools 40, 117
dragging shapes and 54, 368
selecting multiple items 134
selecting shapes and 41

Show group (View tab)
depicted 12
Grid check box 159
Page Breaks check box 160
Task Panes button 22, 85

Show/Hide group (Data tab)
depicted 11
External Data Window button 63
Shape Data Window check box 174

Show/Hide Subordinates button 138
Single Tile button 244
Size button 100
Size group (Format tab) 331, 337
Size & Position window

Angle cell 34
manipulating shapes 29–34
opening 19, 32, 88
panel shapes 344
Pin Pos cell 33
Width cell 32
X cell 33
Y cell 33

sizing
containers 331–333
lists 337

snap-to-grid function 159
Sort dialog box 207
Spacing Options dialog box 149
spacing shapes 144–148
Square shape

accessing 99
positioning 39

Star 5 shape 53
Start custom task process shape 372
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text boxes
applying changes 73
closing 71
creating and formatting 71–73
resizing 72

Text button 71
text edit mode 70
text formatting. See formats/formatting
Text group (Insert tab)

depicted 10
Field button 86
Object button 94
ScreenTip button 82

Text tool 73, 161
Text Transform section (ShapeSheet) 77
theatre box office ticketing process

creating 363–366
creating subprocesses 366–369
publishing drawings to Visio Services 391–397
saving websites to SharePoint servers 387–389
validating 363–366

theme colors 163
theme effects 161
THEME() function 403
themes

accent colors and 164
altering org charts via 130
applying to diagrams 161–162, 163–166
color considerations 163
copying between drawings 169
customizing 166
defined 161
effects for 161
setting options 168

Themes gallery 165, 166
Themes group (Design tab)

Color gallery 166
depicted 11
display examples 162
Effects gallery 167
No Theme button 166
Themes gallery 165, 166

thumbnails
Borders & Titles gallery 106
template 5

TIFF file format 247
tiles

defined 99
print 243

title bars, highlighted 22
Title/Date shape 136
titles, page 71–73

swimlane diagrams
about 111, 119
creating 120–125
list and container usage 338–348
process maps and 355
selecting orientation 121

Switch Windows button 20
System Center Operations Manager (SCOM) 397

T
tabs. See also specific tabs

add-in 16
contextual 15
customizing ribbon 400
temporarily displaying when minimized 15

TaskMap add-in 16, 303
task panes 22
Task Panes button 22, 85
tasks, defined 355
Task shape (BPMN) 364
Template Categories section (New page)

about 3
edition support variations 5
Flowchart option 120
Maps And Floor Plans 255

templates
Auto Size feature 99
business rules and 356
creating 255–259
creating new documents 5
default zoom level 102
defined 17
measurement units and 2
storing 258
thumbnails for 5
Visio Toolbox website and 6

Terminate shape 371
text

adding to shapes 70
orienting in shapes 76–78
positioning in shapes 78–81
replacing 294–296
searching 294–296, 390
typing in containers 328
typing in groups 328

Text Annotation shape (BPMN) 365, 368
Text Block button 78, 79
Text Block tool

about 78
orienting shape text and 78
positioning shape text 78, 79
resizing text blocks 80
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variable lists
defined 172
Format field and 183
selecting entries 177

VBA (Visual Basic for Applications) 408
VBE (Visual Basic Editor) 408
VDW file format 254, 389
VDX file format 252
vertical spacing 149
Views group (View tab) 12
View tab

about 12
components 12
contextual tab sets and 15

Visio development team blog 328, 352
Visio engine 401
Visio Extras group 348
Visio Guy website 277
“Visio Insights” blog 59
Visio Options dialog box

about 8–9
Add-ins category 9
Advanced category 9
Customize Ribbon category 9, 400
Delete Connectors When Deleting Shapes check 

box 61
Editing Options section 26
Enable AutoConnect check box 59
File Locations button 258
General category 9
Language category 9
macro security settings 407
Maximum Number Of Undos setting 62
New Tab button 400
Proofing category 9
Quick Access Toolbar 9, 400
Save category 9
Select Shapes Partially Within Area option 42
Trust Center 9

Visio Premium edition
Backstage view 4
flowchart templates 113
getting started 4
process-related features 355

Visio Professional edition
Backstage view 4
flowchart templates 112
getting started 4

Visio Services
about 379, 389
additional information 390
publishing drawings to 390–397

Tools group (Home tab)
Connector button 48–50, 58, 116
depicted 10
Ellipse tool 40
Freeform tool 46
Line tool 43, 43–44
Pointer tool 45, 50, 278
Pointer Tool button 71, 116
Rectangle tool 40, 278
Text Block button 78, 79
Text button 71
Text tool 161

tooltips
accessing 12
applying color themes 163
following hyperlinks 217
theme examples and 162

transparency, setting 152
Triangle shape 40
Trigger/Result entry (BPMN) 364
troubleshooting

AutoConnect feature 56
Issues window and 357–361, 369

Trust Center 9, 407
two-dimensional shapes

connecting with lines 43
static glue and 52

U
UI shapes 342
Undo feature 62, 128
ungrouping shapes 91
unique ID 190
Upper tab item shape 345
user interface, customizing 399
US units

Block Diagram stencil and 74
defined 2
rack diagrams and 281

V
Vacancy shape 128
validation

BPMN and 361–362, 362–366
data 175–177
diagram 357–361

validation rules
creating new 375
reusing existing 373–375
understanding 356
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work processes
business rules and 356
creating BPMN diagrams 362–366
creating SharePoint Workflow diagrams 370–373
creating subprocesses 366–369
creating validation rules 375
defined 355
diagramming 355
exporting SharePoint Workflow diagrams 370–373
reusing validation rules 373–375
templates supporting 356
understanding BPMN 361–362
validating BPMN diagrams 362–366
validating flowcharts 357–361

workspace, defined 17

X
XAML (Extensible Application Markup 

Language) 380, 384
X-axis positioning 144
XML files 202, 386
XPS file format 8, 253, 255

Y
Y-axis positioning 144

Z
Z-axis positioning 144
Zoom buttons 12
Zoom dialog box 20
zoom feature

changing settings 394
keyboard shortcuts 25–26
Page Setup dialog box 102
repositioning and rotating text 80
returning to full page view 26
Visio Viewer 260

Zoom group (View tab) 73
Zoom Level button 20, 99, 225
Zoom slider 20, 54
Zoom To Fit Page To View button 394
Z-order

defined 144
overriding 146

Visio Standard edition
Backstage view 2
flowchart templates 112
getting started 2

Visio Toolbox 6, 272
Visio Viewer 260–261
Visual Aids group (View tab)

AutoConnect button 56, 367
depicted 12
Dynamic Grid button 38, 41

Visual Basic Editor (VBE) 408
Visual Basic for Applications (VBA) 408
VML file format 384
VSD file format 252, 253
VSS file format 252, 253
VST file format 252, 253
VSX file format 253
VTX file format 253
VWI file format 373

W
Web server shape 277
websites

customizing diagrams saved as 380–386
hyperlinks to 218
publishing diagrams 261–267
saving in SharePoint servers 387–389

Whole Page button 244
Width button 19, 88, 272
Window buttons 12
windows. See also specific windows

docking 173
hiding 173
managing 399
switching among 20

Windows Task Bar 218
wireframe shapes 342–347
Wireframe template 343–347
WMF file format 248
Work Flow Objects stencil 24
workflows, defined 370
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